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Předmluva 
 
 
 
 
 
 

Jak používat tuto příručku 
 
 

Účel této 
příručky 

Tato příručka je určena vědeckým a ostatním laboratorním pracovníkům provádějícím 
absolutní kvantifikaci pomocí Real-Time PCR systémů Applied Biosystems 7300/7500/ 
7500 Fast. 

 

 
  Předpoklady Tato příručka předpokládá, že máte následující znalosti: 

 

•   Jste obeznámeni s operačním systémem Microsoft® Windows® XP. 

•   Jste obeznámeni s technikami pro přípravu a manipulaci se vzorky DNA a 
RNA a jejich přípravou pro PCR. 

•   Máte všeobecné znalosti týkající se pevných disků, ukládání dat, přenosů a 
kopírování souborů. 

 
     Práce s textem Pro lepší pochopení pracuje tato příručka s textem následujícím způsobem: 

 

•   Tučně jsou vyznačeny aktivní zásahy uživatele. Například: 

Napište 0, poté stiskněte Enter pro každé ze zbývajících polí. 

•   Kurzívou jsou vyznačena nová nebo důležitá slova a též zdůraznění. Například: 

Před vlastní analýzou vždy připravte čerstvou matrici. 

•   Znaménko (>) odděluje po sobě následující příkazy, které volíte z rozbalovacích 
menu nebo nabídek. Například: 

Zvolte File > Open. 
 

 
Upozornění 

pro uživatele 
V dokumentaci Applied Biosystems se používají upozornění pro uživatele. Každé 
upozornění vyžaduje určitou míru pozornosti nebo aktivity, jak je popsáno níže: 
 

Poznámka (Note) – Poskytuje informace, které mohou být zajímavé nebo nápomocné, 
ale které nejsou kritické z hlediska používání přístroje. 
 

DŮLEŽITÉ! (IMPORTANT!) – Poskytuje informace, které jsou nezbytné pro správné 
ovládání přístroje, používání reagencií nebo bezpečné používání chemikálií. 

    – VAROVÁNÍ Indikuje potenciálně nebezpečnou situaci, která,  
pokud se jí nevyhnete, může vést k malému nebo středně těžkému zranění. Lze též použít 
jako varování před nebezpečnými činnostmi. 

   – VÝSTRAHA Indikuje potenciálně nebezpečnou situaci, která, pokud 
se jí nevyhnete, může způsobit smrt nebo těžké zranění. 
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Úvodem 
Kde získat více informací 

 
 
 
Kde získat více informací 

 
 

Související 
dokumentace 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Používání  
nápovědy 

Více informací o používání přístrojů 7300/7500/7500 Fast naleznete v příručkách: 
 

•   Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Online Help – 

Nápověda  

•   Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Allelic 
Discrimination Getting Started Guide (Kat.č. 4347822) – Alelická diskriminace 

•   Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Plus/Minus 
Getting Started Guide (Kat.č. 4347821) - Experimenty typu Plus/Mínus 

•   Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Relative 
Quantitation Using Comparative CT Getting Started Guide (Kat.č. 4347824) – 

Relativní kvantifikace pomocí komparativní CT metody 
•   Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System: User Guide for 

the 21 CFR Part 11 Module in SDS Software v1.4 (Kat.č. 4374432) – Uživatelská 

příručka pro modul programu SDS v 1.4 pro práci podle normy 21 CFR část 11 

•   Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Installation and 
Maintenance Guide (Kat.č. 4347828) – Instalace a údržba 

•   Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Site Preparation 
Guide (Kat.č. 4347823) – Příprava místa 

•   Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Performing Fast 
Gene Quantitation Quick Reference Card (Kat.č. 4362285) – Stručný přehled 

•   Applied Biosystems 7500 Fast Real-Time PCR System Using Expert Mode User 
Bulletin (Kat.č. 4367499) – Expertní režim používání 

•   Applied Biosystems Real-Time PCR Systems Computer Setup Guide (Kat.č. 
4365367) – Příprava počítače 

•   Applied Biosystems Real-Time PCR Systems Chemistry Guide (Kat.č. 4348358) – 

Chemizmus 

•   TaqMan Universal PCR Master Mix Protocol (Kat.č. 4351891) 

•   Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 
(Kat.č. 4375575) 

 
Systém nápovědy otevřete kliknutím na ikonu  v záhlaví hlavního okna programu 
SDS nebo pomocí volby Help > Contents and Index (Pomoc > Obsah a Rejstřík). 

 

 
Pošlete nám 
Vaše návrhy 

V Applied Biosystems vítáme Vaše komentáře a návrhy na zlepšení uživatelské 
dokumentace. Své připomínky můžete zaslat na adresu: 

techpubs@appliedbiosystems.com  
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Úvodem 
Kde získat pomoc 

 
 
 
Kde získat pomoc 

 
Nejaktuálnější služby a informace Technické podpory (Support) naleznete na adrese 
http://www.appliedbiosystems.com, kde klikněte na odkaz Support. 

Na stránkách technické podpory můžete: 

•   Získat telefonní a faxová čísla všech oddělení Technické podpory a prodejních 
poboček Applied Biosystems 

•   Prohledávat často kladené otázky - Frequently asked questions (FAQs) 

•   Přímo položit dotaz Technické podpoře 

•   Objednat uživatelské dokumenty Applied Biosystems, bezpečnostní listy (MSDS), 
certifikáty o analýze a další související dokumenty 

•   Stahovat dokumenty ve formátu PDF 

•   Získat informace o školení pro zákazníky 

•   Stahovat programové aktualizace a opravné balíčky 
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Úvodem 
Správná laboratorní praxe 

 
 
 
Správná laboratorní praxe 

 
 

PCR – Správná 
laboratorní 

praxe 

Metodika PCR vyžaduje odpovídající postupy práce, aby nedocházelo ke vzniku falešně 
pozitivních výsledků (Kwok and Higuchi, 1989). Opakované provádění PCR reakcí a 
vysoký počet zpracovávaných vzorků může v principu vést k amplifikaci až jediné DNA 
molekuly (Saiki et al., 1985; Mullis and Faloona, 1987). 
 

•   Při přípravě vzorků pro amplifikaci pomocí PCR používejte čistý laboratorní plášť 
(který nebyl předešle použit při manipulaci s PCR produkty nebo během přípravy 
vzorků) a čisté rukavice. 

•   Máte-li podezření, že rukavice jsou kontaminované, ihned je vyměňte. 

•   Používejte vyhrazené pracovní prostory a zařízení pro: 

•   Přípravu vzorků a přípravu PCR reakcí 

•   Amplifikaci pomocí PCR a post-PCR analýzu 

•   Nikdy nenoste PCR produkty do pracovních prostor vyhrazených pro přípravu PCR. 

•   Otevírejte a zavírejte zkumavky a destičky se vzorky opatrně. Zabraňte rozlití 
vzorků a vytváření aerosolů. 

•   Uchovávejte reakce i reagencie vždy v dokonale uzavřených zkumavkách, 
destičkách apod. 

•   Používejte speciální pipety pro pipetování (tzv. positive displacement pipety) nebo 
špičky bránící šíření aerosolů (s filtrem). 

•   Pravidelně čistěte pracovní plochy a zařízení čerstvě připraveným 10% roztokem 
chlornanu sodného. 

 

 
          Odkazy Kwok, S. and Higuchi, R. 1989. Avoiding false positives with PCR. Nature 339:237- 

238. 
 

Mullis, K.B. and Faloona, F.A. 1987. Specific synthesis of DNA in vitro via a 
polymerase-catalyzed chain reaction. Methods Enzymol. 155:335-350. 

 

Saiki, R.K., Scharf, S., Faloona,F., et al. 1985. Enzymatic amplification of β- globin 
genomic sequences and restriction site analysis for diagnosis of sickle cell anemia. 
Science 230:1350-1354. 

 

 

 

 

 

 

 

 

 

 

 
x Absolutní kvantifikace pomocí standardní křivky – Uživatelská příručka pro systémy 7300/7500/7500 Fast 



  

Úvodem 
Správná laboratorní praxe 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Absolutní kvantifikace pomocí standardní křivky – Uživatelská příručka pro systémy 7300/7500/7500 Fast xi 



Poznámky    
  
  

 

Absolutní kvantifikace pomocí standardní křivky – Uživatelská příručka pro systémy 7300/7500/7500 Fast 1   

Designing 

Performing

Reverse 

 

Kapitola 1 
 
 
 
 
 

         Úvod 1 
 

 
 
 
 
 
 
 
 
 
 
 
 

Úvod 

O systémech 
7300/7500/7500 Fast 

 

 

Viz strana 2 

 

 
 
 
 
 
 

Příprava  
kvantifikačního  
pokusu  
 

 
 
 
 
 
 
 

 

 

  
 

Provedení 
reverzní 
transkripce 
 

 

 O absolutní kvantifikaci 

 

Viz strana 2 
  

 

 
    

 
 
 
 

 
 Provedení  

kvantifikace –  
systém 7500 Fast 
 

 
 
 
 
 
 

Analýza výsledků 
kvantifikace 

 

 

O provádění absolutní 
kvantifikace 

 

 
Viz strana 3 

Provedení  
kvantifikace –  
systém 7300/7500 



Poznámky    
  
  

 

2 Absolutní kvantifikace pomocí standardní křivky – Uživatelská příručka pro systémy 7300/7500/7500 Fast  

Kapitola 1 Úvod  

 

O systémech 7300/7500/7500 

 
 
 
O systémech 7300/7500/7500 Fast 

 

 
Popis Real-Time PCR systémy Applied Biosystems 7300/7500/7500 Fast slouží k detekci a 

kvantifikaci nukleových kyselin v reálném čase a ke kvalitativní detekci nukleových 
kyselin prováděné po skončení reakce (end-point) a pomocí analýzy disociační křivky 
(křivky tání). Real-Time PCR systém Applied Biosystems 7500 Fast umožňuje provádět 
kvantitativní real-time PCR reakce (jako např. relativní kvantifikaci) vysokou rychlostí, 
takže celková doba reakce je kratší než 40 minut. 

 

 
Absolutní 

kvantifikace 
V systémech 7300/7500/7500 Fast se používají 96-jamkové destičky a lze na nich 
provádět experimenty různých typů. Tato příručka popisuje metodu absolutní kvantifikace 
pomocí standardní křivky. 
 

Více informací o dalších typech experimentů naleznete v příručce Real-Time PCR 

Systems Chemistry Guide (Kat.č. 4348358) a v  nápovědě pro systémy 7300/7500/7500 
Fast (Online Help). 

 

 
 

O absolutní kvantifikaci 
 

 
 Definice Absolutní kvantifikace je postup stanovující absolutní množství jedné určité cílové 

sekvence nukleové kyseliny v neznámém vzorku. 
 

 
Real-time PCR 

  
Absolutní kvantifikace se provádí metodou Real-Time PCR. Principem Real-Time PCR 
je monitorovat průběh reakce v reálném čase. Data o průběhu reakce jsou sbírána v jejím 
průběhu a ne až po jejím skončení (tzv. end-point PCR). 
 

Při používání metodiky Real-Time PCR je z hlediska vyhodnocení jednotlivých reakcí 
klíčový ten bod v jejich průběhu, kdy je poprvé detekována amplifikace jejich produktu, a 
nikoliv množství produktu, detekované po skončení reakce. 

 

 
Používání meto-

diky absolutní 
kvantifikace pro 

experimenty typu 
Plus/ Minus a 

alelickou 
diskriminaci 

I když jsou experimenty typu Plus/Minus a alelická diskriminace experimenty typu end-
point (s vyhodnocením po jejich skončení), společnost Applied Biosystems doporučuje je 
provádět a zobrazovat jejich průběh v reálném čase pomocí systémů 7300/7500/7500 
Fast. Došlo-li by k selhání těchto experimentů, je možné na základě amplifikačních grafů 
definovat příčinu tohoto selhání. 
 

Pro provádění experimentů typu Plus/Minus a alelické diskriminace používejte 
metodiku absolutní kvantifikace (dokumenty typu AQ Plate). Řešení případných 
problémů spojených s průběhem těchto experimentů nevyžaduje provedení standardní 
křivky. 
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Kapitola 1  Úvod 
  

O provádění absolutní kvantifikace 

  

  

 

 
       
       
       
       
       

 
 
 
O provádění absolutní kvantifikace 

1 
Postup provádění 

absolutní 
kvantifikace 

Termín “absolutní kvantifikace”, používaný v této příručce, se vztahuje k celému 
procesu absolutní kvantifikace, počínaje syntézou cDNA z RNA (reverzní transkripce) 
až po analýzu výsledků kvantifikace. Absolutní kvantifikace sestává z několika kroků, 
znázorněných na straně iii. 
 

Při absolutní kvantifikaci se používá standardní křivka, na jejímž základě se vypočítává 
množství neznámé cílové sekvence. Výsledky absolutní kvantifikace jsou udávány ve 
stejných jednotkách, v jakých je definována standardní křivka 
 

Systémy 7300/7500/7500 Fast slouží k ukládání dat, získaných na základě analýzy vzorků 
metodou Real-Time PCR. V každém běhu je v rámci dokumentu typu AQ Plate 
analyzována jedna destička. Systémy 7300/7500/7500 Fast umožňují několik různých 
možností analýzy dat. 

 
 

 
 

 
 
 

Reakce v destičce Systém 7300/7500/7500 Fast  Program SDS  Dokument AQ Plate 

 
 
 
 

Analýza výsledků 
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Pojem Definice 

Pozadí (Baseline) Počáteční cykly PCR v nichž dochází k minimálním změnám 
detekované fluorescence. 

Práh (Threshold) Hodnota ∆Rn—automaticky stanovená programem nebo nastavená 
manuálně—používaná pro stanovení parametru CT v Real-Time PCR 
pokusech. Nastavuje se vyšší než hodnota pozadí a dostatečně 
nízko, aby se nacházela v exponenciální fázi amplifikační křivky. Práh 
je přímka, jejíž průsečík s amplifikační křivkou definuje parametr CT. 

Prahový cyklus 
(Threshold cycle - CT) 

Číslo cyklu, v němž hodnota naměřené fluorescence protíná práh. 

Netemplátová kontrola 
(No template control - 
NTC) 

Vzorek, který neobsahuje templát. Používá se pro kontrolu 
amplifikace. 

Cílová nukleová 
kyselina (“templát”) 

Nukleotidová sekvence, kterou chcete detekovat a kvantifikovat. 

Pasivní reference 
(Passive Reference) 

Barva, která funguje jako interní fluorescenční referenční signál, vůči 
němuž je během analýzy výsledků normalizován signál získaný 
měřením amplifikace (signál reporterové barvy). Normalizace je 
nezbytná proto, aby byly odstraněny výkyvy naměřené fluorescence, 
způsobené změnami koncentrace nebo objemu. 

Reportérová barva 
(Reporter dye) 

Barva na 5′ konci TaqMan®  sondy. Její signál je mírou specifické 
amplifikace. 

Normalizovaný signál 
reportérové barvy (Rn) 

Poměr fluorescenčního signálu reportérové barvy 
k fluorescenčnímu signálu pasivní reference. 

Delta Rn (∆Rn) Velikost signálu vytvořeného za daných podmínek PCR reakce.  
(∆Rn = Rn  − pozadí) 

Standard Vzorek o známém množství, používaný pro vytvoření standardní 
křivky 

Neznámý vzorek Vzorek obsahující neznámé množství templátu, které chcete zjistit. 

 

R
n 

O provádění absolutní kvantifikace 

 
 
 

Používané  
pojmy 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Obrázek níže znázorňuje graf amplifikace a jeho součástí jsou i některé shora uvedené 
pojmy. 

 
 
 
 

Vzorek 
 

Rn 
 

 
 

Práh 
 
 
 

Pozadí 
Netemplátová kontrola 

CT 

 
 

0 5 10 15 20 25 30 35 40 

Číslo cyklu 
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O provádění absolutní kvantifikace 

  

  

Položka Dodavatel 

ABI PRISM®  6100 Nucleic Acid PrepStation Applied Biosystems - (Kat.č. 6100-01) 

High-Capacity cDNA Reverse Transcription 
Kit (1000 reakcí) 

 

High-Capacity cDNA Reverse Transcription 
Kit (200 reakcí) 

 

High-Capacity cDNA Reverse Transcription 
Kit with RNase Inhibitor (1000 reakcí) 

 

High-Capacity cDNA Reverse Transcription 
Kit with RNase Inhibitor (200 reakcí) 

Applied Biosystems - (Kat.č. 4368813)  

Applied Biosystems - (Kat.č. 4368814)  

Applied Biosystems - (Kat.č. 4374967)  

Applied Biosystems - (Kat.č. 4374966) 

TaqMan® Universal PCR Master Mix 
 

TaqMan® Fast Universal PCR Master Mix (2X) 
No AmpErase® UNG 

TaqMan® One-Step RT-PCR Master Mix 
 

SYBR®  Green PCR Master Mix 
 

Power SYBR® Green PCR Master Mix 

Applied Biosystems - (Kat.č. 4304437)  

Applied Biosystems - (Kat.č. 4352042) 

 
Applied Biosystems - (Kat.č. 4309169)  

Applied Biosystems - (Kat.č. 4309155)  

Applied Biosystems - (Kat.č. 4367659) 
MicroAmp™ Optical 96-Well Reaction Plate 
with Barcode 

MicroAmp™ Fast Optical 96-Well Reaction 
Plate with Barcode (code 128) 

Applied Biosystems - (Kat.č. 4306737)  

Applied Biosystems - (Kat.č. 4346906) 

MicroAmp™ Optical Adhesive Film 
(100 ks) 

 

MicroAmp™ Optical Adhesive Film 
(25 ks) 

 

MicroAmp™ Adhesive Film Applicator 

Applied Biosystems - (Kat.č. 4311971)  

Applied Biosystems - (Kat.č. 4360954) 

Applied Biosystems - (Kat.č. 4333183) 
 

 
 
 

Další potřebný  
materiál 

 1 
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O provádění absolutní kvantifikace 
 

 
 
 

Položka Dodavatel 

Značené primery a sondy z jednoho 
z následujících zdrojů: 

•   TaqMan®  eseje pro kvantifikaci genové 
 exprese (predesignované primery a sondy) 

–   skladem (inventoried) 

–   ne skladem (na zakázku – non-
 inventoried) 

•   Zakázkové TaqMan® eseje pro kvantifikaci 
genové exprese (predesignované primery 
a sondy) 

–   Small-Scale (20×, 144 × 50 µL 
reakce) 

–   Medium-Scale (20×, 300 × 50 µL 
reakce) 

–   Large-Scale (60×, 1160 × 50 µL 
reakce) 

•   Primer Express® Software (pro návrh 
vlastních primerů a sond) 

–   Licence pro 1 uživatele 

–   Licence pro 5 uživatelů 

 
 
 
 
 

•   Applied Biosystems - (Kat.č. 4331182) 

•   Applied Biosystems - (Kat.č. 4351372) 
 
 
 
 
 

•   Applied Biosystems - (Kat.č. 4331348) 

 
•   Applied Biosystems - (Kat.č. 4332078) 

 
•   Applied Biosystems - (Kat.č. 4332079) 

 

 
 
 

•   Applied Biosystems - (Kat.č. 4363991) 

•   Applied Biosystems - (Kat.č. 4363993) 

6700 reakční zkumavky, 10-mL Applied Biosystems - (Kat.č. 4305932) 

Centrifuga s adapterem na 96-jamkové 
destičky 

Dodavatel laboratorních potřeb (DLP) 

Rukavice DLP 

Mikrocentrifuga DLP 

Zkumavky do mikrocentrifugy, sterilní 1.5-mL DLP 

Voda prostá nukleáz DLP 

Pipetovací špičky s filtrem DLP 

Pipety, typ positive-displacement DLP 

Vortex DLP 
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Kapitola 1  Úvod 
  

O provádění absolutní kvantifikace 

  

  

 
 
 
Absolutní kvantifikace – vzorový pokus 

1 
    Přehled Pro lepší nástin toho jak navrhnout, provést a vyhodnotit pokus absolutní kvantifikace je 

jako příklad níže uveden pokus vzorový. Tento příklad lze použít pro rychlé seznámení  
se s jednotlivými kroky takového pokusu. Detailní popis těchto kroků je dále uveden 
v následujících kapitolách příručky. Součástí těchto kapitol jsou pak i odkazy na tento 
vzorový pokus, které poskytují související detailní údaje. Podrobnější informace 
naleznete v části Příloha E, “Absolutní kvantifikace- vzorový pokus,” na straně 81. 
Chcete-li otevřít vzorový pokus v programu SDS: 

 
1.  Zvolte File > Open (Soubor > Otevřít). 

 
2.  Vyhledejte soubor EXAMPLE_AQ.sds v adresáři Applied 

Biosystems\SDS Documents\Example Data Files\ a klikněte Open 
(Otevřít). 
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O provádění absolutní kvantifikace 
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Přehled 

 
 
 
Přehled 

 
 

Typický kvantifikační pokus (absolutní kvantifikace) se provádí jako jediná PCR reakce 
ve zkumavce (singleplex) za použití primerového páru a sondy TaqMan® nebo 
primerového páru a barviva SYBR® Green. Následující část popisuje přípravu takového 
kvantifikačního pokusu. 

 
 

Definice parametrů kvantifikačního pokusu 
 
 

Pro každý kvantifikační pokus definujte: 
 

•   Neznámá (Unknown) – Kvantifikovaná sekvence nukleové kyseliny. 

•   Standardy – Tato příručka předpokládá, že jste připravili sadu standardů pro každou 
sekvenci, kterou kvantifikujete. V Příloze B na straně 75 naleznete doporučení 
týkající se přípravy standardů. 

•   Replikáty – Pro provádění absolutní kvantifikace doporučuje společnost 
Applied Biosystems používání tří nebo více replikátů (provedení) téže reakce 
od každého vzorku, aby výsledky byly statisticky signifikantní. 

 

Podrobnější informace, týkající se těchto parametrů, naleznete v příručce Real-Time PCR 

Systems Chemistry Guide (Kat.č. 4348358). 
 
 

Vzorový pokus 
 

Ve vzorovém pokusu se provádí kvantifikace genu kódujícího RNázu P ve dvou skupinách (populacích) vzorků na Real 
Time PCR přístroji 7500. Jelikož je kvantifikován pouze jediný gen, je zapotřebí pouze jedna sada standardů (A). Každý 
standard je kvantifikován ve čtyřech replikátech, aby výsledky byly statisticky signifikantní. V pokusech, kde je studováno 
více genů, je zapotřebí připravit sadu standardů pro každý gen (B). 

 
 

A. Jeden gen, dvě skupiny vzorků B. Dva geny, dvě skupiny vzorků 
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Chemizmus Popis 

Reagencie a kity založené na sondách typu 
TaqMan®   

 

Popis 

Reagencie a kity založené na sondách typu 
TaqMan® používají fluorescenčně značenou sondu 
umožňující detekci specifického PCR produktu tak 
jak dochází k jeho akumulaci v průběhu PCR. 

 

Výhody 

•   Sonda zajišťuje vyšší specifitu detekce 
neboť její hybridizace s cílovou DNA je 
sekvenčně závislá a tedy specifická. 

•   Možnost provádět multiplexní reakce. 

•   K dispozici jsou optimalizované eseje. 

•   V průběhu PCR probíhá  5’-nukleázová 
reakce. 

 PCR a detekce cDNA 

 
a. Součásti eseje 
b. Denaturovaný templát a annealing 
c. Tvorba signálu 

LEGENDA 

Náhodné primery 

Reverzní transkriptáza

Barva FAMTM 

Zhášeč 

Minor Groove Binder 

AmpliTaq Gold 
DNA polymeráza 

Sonda 

Primer 

Templát 

Prodlužovaný primer 

 

 

Reagencie na bázi SYBR® Green I  
 

Popis 

Reagencie na bázi barvy SYBR Green I (váže se 
na dvouřetězcovou DNA) umožňují detekci PCR 
produktů tak jak dochází k jejich akumulaci v 
průběhu PCR. 

 

Výhody 

•   Ekonomické řešení (není zapotřebí sondy). 

•   Možnost provádění analýzy disociační křivky. 

•   Vyšší intenzita fluorescenčního signálu s 
rostoucí délkou amplifikačního produktu. 

Omezení 
Váže se nespecificky na veškerou dvouřetězcovou 
DNA. Tvorbu nespecifických produktů reakce 
(falešně pozitivní výsledky) lze ověřit pomocí 
disociační křivky nebo agarózového gelu. 

 

Krok 1: Reakce Barvivo SYBR® 
Green I generuje fluorescenční signál 
je-li vázáno na dvouřetězcovou DNA. 

 
Krok 2: Denaturace 
Je-li DNA denaturována, barvivo 
SYBR® Green I se uvolní a 
fluorescenční signál se dramaticky 
sníží. 

 
 

Krok 3: Polymerace Primery 
nasednou na templát a dochází k jejich 
prodlužování a vzniku PCR produktu. 
 
 
Krok 4: Polymerace ukončena 
Barvivo SYBR® Green I se váže na 
dvouřetězcový produkt reakce, 
dochází k nárůstu detekovaného 
fluorescenčního signálu. 

 

Chemizmus 
 
 
 
Chemizmus 

 
 

O chemizmu 
reakce 

Společnost Applied Biosystems nabízí pro použití v PCR reakci a pro detekci produktů 
amplifikace na Real-Time PCR přístrojích chemizmus dvou různých typů, vysvětlených 
v následující tabulce. Oba typy používaných chemizmů – sondy typu TaqMan® a 
barvivo SYBR® Green I - lze použít v jedno- nebo dvoukrokovém provedení RT-PCR. 
Více informací o používaných chemizmech naleznete v příručce Real-Time PCR 
Systems Chemistry Guide (Kat.č. 4348358). 
 

 
 

 2 
 

 

 



 Kapitola 2  Příprava kvantifikačního pokusu 

Poznámky    
  
  

 

12 Absolutní kvantifikace pomocí standardní křivky – Uživatelská příručka pro systémy 7300/7500/7500 Fast  

  

 

Volba jedno- nebo dvoukrokové RT-PCR 
 
 
 
Volba jedno- nebo dvoukrokové RT-PCR 

 
Při provádění Real-Time PCR máte možnost provést reverzní transkripci (RT) a PCR 
v jediné reakci (jednokroková) nebo ve zvláštních reakcích (dvoukroková). Volba 
použitých reagencií závisí na tom, pro jakou z těchto dvou variant se rozhodnete: 

 

•  Dvoukroková RT-PCR se provádí ve dvou zvláštních reakcích: Nejprve se provede 
přepis (reverzní transkripce) celkové RNA do cDNA a následně se cDNA 
amplifikuje PCR. Tato metoda je vhodná pro detekci více transkriptů z jednoho 
cDNA templátu nebo pro uchovávání alikvotů cDNA pro jejich pozdější využití. 
Pro zabránění vzniku kontaminace lze použít enzym AmpErase® UNG. 

Uživatelé systému 7500 Fast mohou využít TaqMan® Fast Universal PCR Master 
Mix nebo TaqMan® Universal PCR Master Mix – tyto analýzy trvají přibližně 40 
minut nebo 2 hodiny. 

 
DŮLEŽITÉ!  Tato příručka je věnována zejména pokusům absolutní kvantifikace 
využívajícím dvoukrokovou RT-PCR, nicméně její součásti jsou i informace 
o jednokrokové RT-PCR. Více informací naleznete v příručce Real-Time PCR 

Systems Chemistry Guide. 
 
 
 

Poznámka:  TaqMan® Fast Universal PCR Master Mix neobsahuje enzym 
AmpErase® UNG. 

 
 

•   Při jednokrokové RT-PCR probíhají RT a PCR v témže pufračním systému, což 
umožňuje provést obě reakce v jediné zkumavce. V tomto uspořádání nicméně není 
možné použít Fast PCR Master Mix nebo AmpErase® UNG (uracil-N-glykosylázu) 
pro zabránění kontaminace. Více informací o UNG naleznete v příručce Real-Time 

PCR Systems Chemistry Guide. 
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Ampllfikace PCR a 
detekce 
 

 

Amplifikace 
PCR a detekce

 Volba jedno- nebo dvoukrokové RT-PCR  
 
 
 
 

Dvoukroková RT-PCR Jednokroková RT-PCR 
 

Vzorek RNA Vzorek RNA 

 
Master mix pro RT 

 
Mastermix 
pro RT  

 
Mastermix pro 
standardní PCR  

 

 

 

 
Inkubace RT  

Alikvot DNA 
 

 

 

 
Uložit 

 
Inkubace RT a 
amplifikace PCR 

2 
 
 
 

Master mix pro standardní PCR
  

Fast PCR Master Mix  
Výsledky 

   2.5 hod 

 
 
 
 
 

Výsledky 
2 hod 

Výsledky 
  < 40 minut 

 
 

Doporučené kity pro dvoukrokovou RT-PCR 

Chemizmus Krok Kit nebo reagencie       Kat. č. 

RT High-Capacity cDNA Reverse Transcription 
Kit (1000 reakcí) 

 

High-Capacity cDNA Reverse Transcription 
Kit (200 reakcí) 

 

High-Capacity cDNA Reverse Transcription 
Kit with RNase Inhibitor (1000 reakcí) 

 

High-Capacity cDNA Reverse Transcription 
Kit with RNase Inhibitor (200 reakcí) 

4368813 
 

 
4368814 

 

 
4374967 

 

 
4374966 

TaqMan reagencie nebo kity 

PCR TaqMan® Universal PCR Master Mix 
 

TaqMan® Fast Universal PCR Master Mix (2X) 
No AmpErase® UNG 

4304437 
 

4352042 
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Volba sond a primerů 
 

 
 

Doporučené kity pro dvoukrokovou RT-PCR 

Chemizmus Krok Kit nebo reagencie       Kat. č. 

RT High-Capacity cDNA Reverse Transcription 
Kit (1000 reakcí) 

 

High-Capacity cDNA Reverse Transcription 
Kit (200 reakcí) 

 

High-Capacity cDNA Reverse Transcription 
Kit with RNase Inhibitor (1000 reakcí) 

 

High-Capacity cDNA Reverse Transcription 
Kit with RNase Inhibitor (200 reakcí) 

4368813 
 

 
4368814 

 

 
4374967 

 

 
4374966 

PCR SYBR®  Green PCR Master Mix 
 

Power SYBR®  Green PCR Master Mix 
4309155 

 

4367659 

SYBR®  Green I reagencie nebo 
kity 

RT a PCR SYBR®  Green RT-PCR Reagents 4310179 
 
 

Vzorový pokus 
 

Ve vzorovém pokusu byla použita dvoukroková RT-PCR s reagenciemi a kity TaqMan uvedenými v tabulce výše. 
 
 
 

Volba sond a primerů 
 
 

Pro vaši cílovou sekvenci zvolte primery a sondu. Společnost Applied Biosystems vám 
nabízí tři možnosti jak zvolit primery a sondu: 

 

•   TaqMan® Gene Expression Assays (TaqMan® eseje pro kvantifikaci genové 
exprese) – Připravené, optimalizované (ready-to-use) TaqMan eseje (5′-nukleáza) 
pro lidské, myší nebo krysí transkripty. Více informací o primerech a sondách, které 
jsou k dispozici, naleznete na http://www.allgenes.com 

•   Custom TaqMan® Gene Expression Assays (TaqMan® eseje pro kvantifikaci 
genové exprese – na objednávku) – Design, syntéza, složení a dodávka sady primerů 
a sond se zaručenou kontrolou jakosti. Tato služba je vhodná v případě, že 
požadovaná sada primerů/sond není aktuálně k dispozici. Chcete-li využít tuto 
možnost, kontaktujte vašeho zástupce Applied Biosystems. 

•   Primer Express® Software – Vhodný pro návrh primerů a sond pro vaše vlastní 
kvantifikační experimenty. Více informací o používání tohoto programu naleznete 
v příručce Primer Express Software v3.0 Getting Started Guide (Kat.č. 4362460). 

Společnost Applied Biosystems doporučuje pro návrh esejí specifické postupy 
(Assay Design Guidelines), které, jsou-li dodržovány, představují spolehlivý systém 
návrhu a optimalizace. Více informací o těchto doporučeních naleznete v příručce 
Real-Time PCR Systems Chemistry Guide. 

 
 

Vzorový pokus 
 

Primery a sondy pro RNázu P byly navrženy pomocí programu Primer Express. 
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Kapitola 3  Provedení reverzní transkripce 
Doporučení pro přípravu RNA 

 
  

 
 
 
Doporučení pro přípravu RNA 

 
 

Izolace 
celkové RNA 

Společnost Applied Biosystems dodává přístrojové platformy, chemizmy a protokoly pro 
izolaci RNA z různého výchozího materiálu jako je krev, tkáně, buněčné kultury nebo 
rostlinné tkáně. 

 

Platforma, chemizmus nebo protokol Dodavatel 

Přístroj pro izolaci nukleových kyselin ABI PRISM®  6100 
Nucleic Acid PrepStation 

Applied Biosystems  
(Kat.č. 6100-01) 

6100 Reagents and Disposables Starter Kit (Reagencie a 
plastik pro přístroj 6100) 

Applied Biosystems 
(Kat.č. 4328773) 

Zkumavka Tempus™  Blood RNA Tube 
(Pro odběr, stabilizaci a izolaci celkové RNA z plné krve 
pomocí přístroje 6100 za účelem analýzy genové 
exprese) 

Applied Biosystems 
(Kat.č. 4342792) 

Protokol pro izolaci celkové RNA z plné krve a z buněk 
izolovaných z plné krve 

Applied Biosystems 
(Kat.č. 4332809) 

Protokol pro zkumavky Tempus™  Blood RNA Tube a 
zkumavky na větší objemy 

Applied Biosystems 
(Kat.č. 4345218) 

Izolace RNA z tkání: Protokol pro izolaci celkové RNA 

z rostlinných a živočišných tkání  
Applied Biosystems 

(Kat.č. 4330252) 

 
Kvalita RNA Celková RNA, kterou chcete použít pro pokus absolutní kvantifikace, by měla: 

 

•   Mít poměr A260/280 větší než 1.9 
•   Být nedegradovaná (vizualizace pomocí gelové elektroforézy) 

•   Neměla by obsahovat inhibitory RT nebo PCR 
 

V protokolu pro kity High-Capacity cDNA Reverse Transcription Kits (Kat.č. 4375575) 
naleznete další doporučení stran přípravy RNA. 

 

 
Úprava výchozí 

koncentrace 
celkové RNA 

Kity High-Capacity cDNA Reverse Transcription Kits jsou optimalizovány pro přepis až 
2 µg celkové RNA do cDNA v jedné 20 µL reakci. Použijte dostatečné množství celkové 
RNA tak, aby výsledná koncentrace celkové RNA přepisované do cDNA byla 10 až 
100 ng v 5 µL pro každou PCR reakci o objemu 50-µL. 

 
 

Poznámka:  Máte-li podezření, že RNA není prostá RNázové aktivity, přidejte do reakce 
reverzní transkripce inhibitor RNáz ve výsledné koncentraci 1.0 U/µL. 



Poznámky    
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Krok Doba Teplota 

HOLD (Inkubace) 10 min 25 °C 

HOLD (Inkubace) 120 min 37 °C 

HOLD (Inkubace) 5 sec 85 °C 

 

Kapitola 3  Provedení reverzní transkripce  
 
  

Přepis celkové RNA do cDNA  

 
 

 

  

 
 
 
Přepis celkové RNA do cDNA 

 
 

Použití kitů  
High-Capacity 

cDNA Reverse 
Transcription Kits 

Pro provedení prvního kroku (RT) dvoukrokové RT-PCR použijte High-Capacity 
cDNA Reverse Transcription Kit. Postupujte podle metodiky pro přepis celkové 
RNA do cDNA tak, jak je uvedena v protokolu pro High-Capacity cDNA Reverse 
Transcription Kits Protocol (Kat.č. 4375575). 

 
 

DŮLEŽITÉ!  Spolu s kitem High-Capacity cDNA Reverse Transcription Kit se  
nedodává protokol. Protokol je k dispozici na  

 
http://docs.appliedbiosystems.com/search.taf 

 
Do pole pro vyhledání zadejte ABI PRISM® 6100 Nucleic Acid PrepStation a 
klikněte na tlačítko Search (Hledat) v dolní části stránky. Protokol naleznete v části 
Protocols (Protokoly). 

 

 
Teplotní profil 

pro RT 
Pro RT prováděnou pomocí kitů High-Capacity cDNA Reverse Transcription Kits  
použijte následující teplotní profil. 

3 
  
 
 
 
 
 
 
 
 

Poznámka:  Používáte-li PCR cykler, můžete přidat dodatečný krok – inkubaci při 4 °C. 
Více informací naleznete v příručce Applied Biosystems High-Capacity cDNA 
Reverse Transcription Kits Protocol (Kat.č. 4375575). 

 
 
 

Poznámka:  Teplotní profil pro jednokrokovou RT-PCR je popsán na straně 30. 
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18 Absolutní kvantifikace pomocí standardní křivky – Uživatelská příručka pro systémy 7300/7500/7500 Fast  

  

 

 

 
 
  

 

Kapitola 3  Provedení reverzní transkripce 
Přepis celkové RNA do cDNA

 

 
 
 

Uchovávání cDNA Uchovávejte všechny vzorky cDNA při teplotách −15 až −25 °C. Aby bylo 
minimalizováno opakované rozmrazovaní a zamrazování, uchovávejte vzorky cDNA 
v alikvotech. 

 
 

CHEMICKÉ RIZIKO. Pufr 10 × Reverse Transcription Buffer 
může způsobit podráždění očí, kůže a dýchacího ústrojí. Přečtěte si bezpečnostní list a 
dodržujte pokyny při manipulaci. Používejte prostředky ochrany očí, ochranný oděv a 
rukavice. 

 
 

 
Vzorový pokus – destička typu Standard  

 
Ve vzorovém pokusu byla celková RNA izolována z krve a byla stanovena její koncentrace (pomocí A260). 

Podle následujícího postupu a při dodržení doporučení uvedených v protokolu High-Capacity cDNA Reverse Transcription 
Kits Protocol (Kat.č. 4375575) byl připraven RT mastermix: 

 
Složka µL/reakci µL/27 reakcí‡ 

10× pufr pro reverzní transkripci (Reverse 
Transcription Buffer) 

2.0 54 

25× dNTPs 0.8 21.6 

10× náhodné primery 2.0 54 

MultiScribe™ reverzní transkriptáza, 50 U/µL 1.0 27 

Voda prostá nukleáz 4.2 113.4 

Celkem 10 270 

‡  Každá RT reakce má objem 20 µL (viz níže). Potřebujete-li 5 µL cDNA pro každou PCR reakci (celkem 104 PCR reakcí, 
každá o objemu 50-µL) (viz “Příprava mastermixu na PCR” na straně 20), je zapotřebí provést 27 reakcí RT. Tato 
kalkulace již bere v úvahu nutnost použít vyšší objem, aby byly eliminovány ztráty vzniklé v důsledku pipetování a též za 
účelem uchování vzorku cDNA. 

 
Následně byla připravena destička se vzorky cDNA– do každé jamky bylo pipetováno: 

 

•   10 µL RT mastermixu 

•   10 µL vzorku RNA  
 

 
 
 
 
 
 
 
 
 
 
 
 

RNA byla přepsána do cDNA za použití teplotního profilu pro dvoukrokovou RT-PCR jak je popsáno v části “Teplotní profil 
pro RT” na straně 17. 

 

cDNA byla až do dalšího použití uchovávána při −20 °C. 



Poznámky    
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Kapitola 4 
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Provedení absolutní kvantifikace – 
systém 7300 nebo 7500 Standard  

 
 
 
 
 
 
 
 
 
 

Úvod 
 
 
 
 
 
 
 
 

Příprava 
kvantifikačního 
pokusu 

Dříve než začnete 
 
 
 
 
 
 
 
 

Příprava 
PCR mastermixu 

Viz strana 20 
 
 
 
 
 
 
 
 
 
Viz strana 20 

 
 
 
 
 
 
 
 

  
 

  
 

Provedení 
reverzní 
transkripce Příprava destičky  

Viz strana 21 
  

 

  

4 
 
 

 
 

 
 

STANDARD 
Provedení 
kvantifikace 
– systém 
7300/7500 

 
    NEBO 

 
 
 
 
 
 
 
 
Analýza výsledků 
kvantifikace 

Provedení  
kvantifikace –  
systém 7500 Fast 

 

Vytvoření dokumentu destičky 
pro absolutní kvantifikaci 
 
 
 
 
 
 
 

 
Nastavení teplotního 

profilu a spuštění běhu 

 

 
Viz strana 24 
 
 
 
 
 
 
 
 
 
Viz strana 29 
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   Dříve než začnete 

 
 
 

Dříve než začnete 
 
 

Ověřte, že na systémech 7300 nebo 7500 Standard je pravidelně prováděna kalibrace 
pozadí a kalibrace barev, takže je zajištěno jejich optimální fungování. Více informací 
o kalibracích systémů 7300/7500 naleznete v Nápovědě (Online Help) a v příručce 
Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Installation and 

Maintenance Guide. 
 
 

Příprava PCR mastermixu 
 

Druhým krokem (PCR) dvoukrokové procedury RT-PCR je amplifikace cDNA, která 
se provádí pomocí mastermixu TaqMan® Universal PCR Master Mix. 

 

Používání reagencií je detailně popsáno v protokolu TaqMan Universal PCR Master 

Mix Protocol (kat. č. 4351891). V následující tabulce jsou uvedeny univerzální 
podmínky experimentu (objem a výsledná koncentrace) pro používání tohoto 
mastermixu. 

 
 

CHEMICKÉ RIZIKO. TaqMan Universal PCR Master Mix 
(2×) No AmpErase UNG může způsobit podráždění očí a kůže. Polknutí nebo 
inhalace může vést k nevolnosti.  Přečtěte si bezpečnostní list a dodržujte pokyny 
při manipulaci. Používejte prostředky ochrany očí, ochranný oděv a rukavice. 

 
 

Reagencie µL/ vzorek  Výsledná koncentrace 

TaqMan® Universal PCR Master Mix (2×) 25.0 1× 

Forward primer 5.0 50 až 900 nM 

Reverzní primer 5.0 50 až 900 nM 
Sonda TaqMan®  5.0 50 až 250 nM 

Vzorek cDNA 5.0 10 až 100 ng 

Voda prostá nukleáz 5.0 — 

Celkem 50.0 — 
 

Navrhujete-li primery a sondy pomocí programu Primer Express®, musíte je 
optimalizovat takovým způsobem, aby fungovaly za použití univerzálních reakčních 
podmínek a shora uvedených objemů. Optimalizace primerů je popsána v příručce 
TaqMan Universal PCR Master Mix Protocol (kat. č. 4351891). Všechny eseje pro 
kvantifikaci genové exprese (TaqMan® Gene Expression Assays) a vlastní eseje pro 
kvantifikaci genové exprese (Custom TaqMan® Gene Expression Assays) jsou vždy 
dodávány v takovém složení, aby byla dodržena doporučení stran výsledné koncentrace 
primerů a sond. 

 SSTTAANNDDAARRDD 
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Příprava destičky 

 
 

Standardní 
destičky a 

destičky Fast  

DŮLEŽITÉ!  Ujistěte se, že na Real-Time PCR systému 7500 používáte standardní 
optické 96-ti jamkové destičky (Standard Optical 96-Well Plate). Optické destičky 
typu Fast nelze umístit do standardního bloku . 

 

 
Destičky Fast Standardní destičky 
(kat. č. 4346906) (kat. č. 4306737) 

 
 

 
 
 
 

Šikmý roh  
vlevo nahoře 
(A1) 

Šikmý roh vpravo 
nahoře (A12) 
 

 
 
 
 
 

Maximální objem 
reakce 30-µL 

 

 
Maximální objem 
reakce 100-µL  

 
 
 

1.  Označte si destičku a ujistěte se, že máte pro každou detekovanou cílovou sekvenci 
připravenou sadu standardů. Standardy musí být na téže destičce. 

 

Poznámka:  Uspořádání reakcí na destičce (vzorky a eseje) by mělo odpovídat 
popisu (názvy vzorků a detektorů/markerů) v dokumentu destičky pro daný běh. 

 4 

2.  Pipetujte 50 µL odpovídajícího PCR mastermixu do každé jamky destičky. 
 

Poznámka:  Reakce obsahující standardy připravujte naprosto totožným způsobem 
jako reakce obsahující neznámé vzorky. Používejte tytéž primery a sondy, složky 
PCR mastermixu a objem, ale do každého standardu přidejte známé množství 
templátu (jako je cDNA nebo plazmidová DNA). Všechny součásti před 
pipetováním do jamek destičky smíchejte. 

 
 

3.  Uzavřete destičku pomocí optické adhezívní fólie. 
 

4.  Krátce destičku centrifugujte. 
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 Příprava destičky 

 
 
 

5.  Ověřte, že se všechny reakce nacházejí na dně jamky. 
 

 
Správně Špatně 

 
 
 
 
 
 
 
 
 

Reakce je na dně jamky. Reakce je na boku jamky, 
protože destička nebyla 
centrifugována. 

Na dně jamky je vzduchová 
bublina – reakce nebyla 
centrifugována dostatečně 
dlouho nebo při dostateč- 
ných otáčkách. 

 
 
 

DŮLEŽITÉ!  Před spuštěním běhu se ujistěte, že se všechny reakce nacházejí na dně 
jamky. Není-li tomu tak, bude ovlivněna kvalita měření. 

 
 

6.   Destičku s reakcemi držte na ledu až do té doby, kdy jste připraveni ji umístit do 
přístroje. 

 SSTTAANNDDAARRDD 
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Vzorový pokus 
 

Při přípravě mastermixů pro PCR byly dodrženy univerzální reakční podmínky. 
 

 
Reagencie 

 
  µL/reakci 

 
µL/5 reakcí‡ 

 
µL/37 reakcí§ Výsledná 

koncentrace 

TaqMan Universal PCR Master Mix (2×) 25.0 125.0 925.0 1× 

Forward primer 5.0 25.0 185.0 50 až 900 nM 

Reverzní primer 5.0 25.0 185.0 50 až 900 nM 

Sonda TaqMan 5.0 25.0 185.0 50 až 250 nM 

Vzorek cDNA nebo templát standardu 5.0 25.0 185.0 10 až 100 ng 

Voda prostá nukleáz 5.0 25.0 185.0 — 

Celkem 50.0 250.0 1850.0 — 

‡   Pro každý z šesti standardů byl připraven jeden mastermix (4 replikáty a rezervní objem pro ztráty při pipetování). 
§   Pro každou z obou skupin (populací) vzorků byl připraven jeden mastermix (36 vzorků a rezervní objem pro ztráty při pipetování). 

 
 

Vzorky obsahující kvantifikovanou cílovou sekvenci i standardy byly uspořádány v destičce. Do každé jamky bylo 
pipetováno 50 µL odpovídajícího PCR mastermixu. Destička byla až do vložení do systému 7500 inkubována na 
ledu. 

 

 
 
 
 
 
 
 
 
 
 

4 

 SSTTAANNDDAARRDD 
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 Vytvoření dokumentu destičky pro absolutní kvantifikaci 

 
 
 

Vytvoření dokumentu destičky pro absolutní kvantifikaci 
 

 
    Přehled Dokument destičky pro absolutní kvantifikaci slouží k uchování dat z jednoho běhu, 

zároveň slouží k uchování dalších údajů o běhu jako jsou názvy vzorků a detektory. 
 

 
Nastavení 

běhu 
Pro každý vytvářený dokument destičky pro absolutní kvantifikaci musíte specifikovat 
detektory, standardy a úlohu detektoru (detector task): 
 

•   Detektor je virtuálně vyjádřená genově specifická kombinace primerů a sondy, které 
jsou používány v dané eseji. Pro každou detekovanou sekvenci vždy zadáváte 
detektor. Vytvoření detektorů je popsáno v Příloze A na straně 73. 

•   Standard je cílová sekvence o známém množství. Pro každou cílovou 
sekvenci používanou na destičce musíte mít sadu standardů. 

•   Úloha detektoru (detektor task) udává, k čemu program používá data naměřená 
v průběhu analýzy. Každému detektoru je přiřazena jedna ze tří úloh. 

 

 
Úloha Symbol Použijte pro detektory... 

 
Neznámý vzorek  V jamkách obsahujících cílovou kvantifikovanou sekvenci. 
(Unknown)  

 
Standard V jamkách obsahujících vzorky o známém množství. 
 
 

Netemplátová 
kontrola (No Temp-
late Control - NTC) 

 

 

V jamkách obsahujících PCR reagencie ale nikoliv templát (negativní kontrola). 
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SSTTAANNDDAARRDD 

 
 
Vytvoření dokumentu destičky pro absolutní kvantifikaci 

 

Informace o vzorcích můžete do nového dokumentu 
destičky zadat, vložit pomocí kopírování z již 
existujících dokumentů destičky, importovat 
z existujících dokumentů destičky nebo definovat 
pomocí templátu. V této části je popsáno vytvoření 
nového dokumentu destičky prostřednictvím zadání 
údajů. Více informací o kopírování nebo importování 
informací o vzorcích z existujících dokumentů destiček 
nebo o používání templátů naleznete v Nápovědě. 

 
 
Poznámka:  Popsaný postup používá vzorová 
experimentální data (viz strana 7). 

 
 
Vytvoření nového dokumentu destičky: 

 
1.  Zvolte Start > All Programs > Applied 

Biosystems > 7300/7500 System > 7300/7500 
System Software ( ), čímž spustíte SDS 
software. 

 
2.  V okně Quick Startup document zvolte 

Create New Document (Vytvořit nový dokument). 
 
 
 
 
 

4 
 

 3.  V rozbalovacím menu Assay (Esej) v okně New 
Document Wizard (Průvodce vytvořením nového 
dokumentu) zvolte Standard Curve (Absolute 
Quantitation) (Standardní křivka – Absolutní 
kvantifikace). Použijte přednastavené možnosti 
v nabídkách  Container (96-Well Clear – 96-ti 
jamková destička) a Template (Templát) – Blank 
document (Nevyplněný dokument). Zvolte 
odpovídající režim běhu (Standard 7300, 
Standard 7500 nebo 9600 Emulation). 

 
DŮLEŽITÉ!  Pro absolutní kvantifikaci 
nemůžete použít dokument typu RQ (Relativní 
kvantifikace) a opačně. 

 
 

4.  V poli Plate Name (Název destičky) zadejte název a klikněte Next > (Další). 
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5.  Zvolte detektory, které chcete přidat do dokumentu destičky. 

 
a.  Kliknutím označte detektor, např.  

RNase P (RNázaP). (Ctrl-klik zvolíte více  
detektorů.) Pokud ve Správci detektorů  
(Detector Manager) nejsou žádné detektory,  
klikněte na New Detector (Nový detektor),  5a 
čímž otevřete dialogové okno New Detector.  
Více informací o vytváření nových detektorů 5b 
naleznete v Příloze A na  straně 73. 

 

b.  Klikněte na Add >> (Přidat), čímž 
přidáte detektory do dokumentu destičky, 
následně klikněte na Next > (Další). 

5b 

Poznámka:  Chcete-li odstranit detektor  
z okna Detectors in Document (Detektory  
v dokumentu), označte jej a klikněte 
Remove (Odstranit).  

 
 

6.  Pro každou jamku definujte detektory a jejich úlohu. 
 

a.  Označte jamku (nebo skupinu jamek,  
pro replikáty). 

b.  Klikněte na název detektoru(ů), čímž jej 
přiřadíte označené jamce. 

c.  Ve sloupci Task (Úloha) zvolte úlohu 
detektoru. 

d.  Pro jamky obsahující standardy 
zadejte jejich množství. 

 

e.  Klikněte Use (Použít). 

Úloha a barva detektoru se zobrazí ve 
zvolených jamkách. 

6b 
f.   Klikněte Finish (Ukončit). 

Program SDS vytvoří dokument destičky. 6e 

 

6c 6d 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6a 
 

6f 
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7.  Zadejte názvy vzorků. 
 

a.  Klikněte na   nebo zvolte View > Well  
Inspector (Zobrazit > Prohlížeč jamek). 

 
Poznámka:  Názvy vzorků lze zadat i tak, že 
označíte vybrané jamky a napíšete název. 

 
 

b.  Klikněte na jamku nebo označte více jamek. 
 

c.  Zadejte název vzorku. 
 

d.  Je-li zapotřebí, změňte zvolenou 
pasivní referenci. (Přednastavena je 
barva ROX™.) 

 

e. Opakujte kroky b až d tak dlouho, až zadáte 
názvy vzorků, a definujete pasivní referenci 
pro všechny jamky na destičce, poté 
klikněte na ( ), čímž okno Well Inspector 
uzavřete. 

 
Poznámka:  Zadané informace (název 
vzorku, detektor, úloha detektoru) můžete 
změnit po skončení běhu. 

 
 
 
 
 
 
 
 
7b 7c 7d 7e 

 
 
 

DŮLEŽITÉ!  Pokud v pokusu nepoužíváte 
všechny jamky destičky, nevyřazujte je nyní 
z analýzy (pomocí funkce Omit - Vypustit). 

Můžete tak učinit až po skončení běhu. Více 4 
informací naleznete v  nápovědě . 

 
 

8.  V záložce Setup (Nastavení) ověřte, že jste 
všechny informace zadali správně. 
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 Vytvoření dokumentu destičky pro absolutní kvantifikaci 

  
 

 

 
 
 

 
 
Vzorový pokus 

 
Kvantifikované vzorky i standardy byly uspořádány na jedinou destičku. Každé jamce byl přiřazen detektor 
(symbol barevného čtverečku). Každé jamce byla rovněž přiřazena úloha detektoru — U (unknown – Neznámý vzorek), 
S (standard) nebo N (no template control – netemplátová kontrola). 

 

Jelikož byl kvantifikován pouze jeden gen, byl definován pouze jediný detektor (nazvaný RNase P – RNáza P). 
 

Obrázek níže znázorňuje vzorový dokument destičky pro absolutní kvantifikaci poté, co byly zadány názvy vzorků, detektor 
a úlohy detektoru pro každou jamku. 

 
 
 
 
 
 

Název vzorku 
 
 

Úloha detektoru a 
barva 
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Časy a teploty (Dvoukroková RT-PCR) 

HOLD (Inkubace) HOLD (Inkubace) HOLD (Inkubace)  
1) RT  

10 min při 25 °C 120 min při 37 °C 5 sec při 85 °C 

Počáteční kroky PCR (40 cyklů) 

Aktivace AmpErase®  

UNG 
Aktivace AmpliTaq 

Gold® DNA polymerázy  
Denaturace Annealing/Polymerace 

HOLD (Inkubace) HOLD (Inkubace) CYCLE (Cyklování) 

 
 
 

2) PCR  

2 min při 50  °C 10 min při 95 °C 15 sec při 95 °C 1 min při 60 °C 

 

 

 
SSTTAANNDDAARRDD 

 
 
Nastavení teplotního profilu a spuštění běhu 

 
 

Univerzální 
teplotní profil 

pro PCR 

Pokud jste si pro váš pokus absolutní kvantifikace zvolili dvoukrokovou RT-PCR 
(doporučeno), již jste provedli krok reverzní transkripce. Nyní provedete amplifikaci 
DNA pomocí PCR. 
 

 
 

V záložce Instrument (Přístroj) se zobrazí přednastavený teplotní profil PCR, viz 
následující tabulka Časy a teploty (Dvoukroková RT-PCR). 

 
 

 
 
  

4 
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SSTTAANNDDAARRDD 
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Nastavení teplotního profilu a spuštění běhu 

 
 
 

Teplotní profil pro 
jednokrokovou 

RT-PCR 

Pokud jste si zvolili jednokrokovou RT-PCR, probíhá přepis do cDNA a její amplifikace 
v jediném kroku. 
 

 
 

Následující tabulka Časy a teploty (Jednokroková RT-PCR) udává teplotní profil pro 
jednokrokovou RT-PCR. 

 
 

Časy a teploty (Jednokroková RT-PCR) 

Počáteční kroky PCR (40 cyklů) 

Reverzní transkripce Aktivace AmpliTaq® Gold 
DNA polymerázy 

Denaturace Annealing/Polymerace 

HOLD (Inkubace) HOLD (Inkubace) CYCLE (Cyklování) 

30 min při 48 °C 10 min při 95 °C 15 sec při 95 °C 1 min při 60 °C 
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Nastavení teplotního profilu a spuštění běhu 

 
SSTTAANNDDAARRDD 

 

 
 
 
Teplotní profil nastavíte a běh spustíte takto: 

 
1.  Zvolte záložku Instrument (Přístroj). 

 

Zobrazí se přednastavený teplotní profil 
(standardní podmínky pro PCR při dvoukrokové 
RT-PCR). 

 
2.  Ověřte, že: 

•   Používáte-li dvoukrokovou RT-PCR – je 
nastaven přednastavený teplotní profil PCR. 

 
Poznámka: Používáte-li jednokrokovou  
RT-PCR, použijte teplotní profil uvedený 
v části “Teplotní profil pro jednokrokovou  
RT-PCR” na straně 30. 

 
 

•   Objem vzorku je 50 µL. 

•   Je nastaven požadovaný Run Mode (Režim 
běhu). 

 
 

Poznámka:  Používáte-li chemizmus SYBR® 

Green I a chcete ověřit přítomnost kontaminací 
či stanovit disociační teplotu vašich amplikonů, 
klikněte na Add Dissociation Stage (Přidat 
krok disociace). Tento krok zahrnuje i 
ochlazení po skončení disociační analýzy. Více 
informací naleznete v  nápovědě. 

4 
 

 
Poznámka:  V systému 7300 není k dispozici 
modelování běhu přístroje 9600 (Emulation). 
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Nastavení teplotního profilu a spuštění běhu 

 
 
 

3.   Zvolte File > Save (Soubor > Uložit), zadejte 
název dokumentu destičky a klikněte Save 
(Uložit). 

 

(Volitelné) Chcete-li tento dokument destičky 
použít znovu, uložte jej jako templát. Zvolte File 
> Save As (Soubor > Uložit jako). 
V rozbalovacím menu Save in (Uložit v) 
vyhledejte adresář Applied Biosystems\ 
7300\7500\7500 Fast System\Templates 
(Templáty). Zadejte název souboru, zvolte typ 
souboru (*.sdt) v Save as type (Uložit jako typ) 
a uložte soubor jako templát. 

 
4.  Vložte destičku do přístroje. 

 
Poznámka:  Pozice A1 je v levém horním rohu  
zásuvky přístroje. 

 
 

5.  Klikněte Start. 
 

Během provádění PCR zobrazuje přístroj 
v záložce Instrument (Přístroj) informace 
v reálném čase a udává naměřené hodnoty 
fluorescence. 

Po skončení běhu jsou stavové hodnoty a tlačítka 
šedá a tlačítko Analysis (Analýza)  je aktivní. 
Současně se objeví zpráva oznamující úspěšné či 
neúspěšné ukončení běhu.

 
 
 
 
 

Jamka A1 Systém 7300/7500: 
Standardní destičky – 
šikmý roh vpravo 
nahoře 

 
 

Veškerá data vytvořená v průběhu běhu jsou 
uložena do dokumentu destičky tak jak byl zadán 
v kroku 3. 

12 
 
 
 
 
 

1      2      3      4      5      6      7      8      9      10     11     12 

A B 

C 

D E 

F G 

A1 
1 

A 

 

 
 
 
Systém 7500 Fast: 
Destičky Fast – 
šikmý roh vlevo 
nahoře 
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Introduction 

Performing
Reverse

 

  

 

 

Provedení 
kvantifikace – 
systém 7300/7500 

Kapitola 5 
 
 
 
 
 

FFAAST 
Provedení absolutní kvantifikace – 

systém 7500 Fast 
 
 
 
 
 
 
 
 
 
 

Úvod 
 
 
 
 
 
 
 
 

Příprava 
kvantifikačního 
pokusu 

Dříve než začnete 
 
 
 
 
 
 

Příprava 
PCR mastermixu 
 
 
 
 
 
 

Příprava destičky 

Viz strana 34 
 
 
 
 
 
 
 
 Viz strana 34 
 
 
 
 
 
 
 
  Viz strana 35 

 

 
 
Provedení reverzní  
transkripce 

 

´  
 

 
 

Vytvoření dokumentu destičky  
pro absolutní kvantifikaci 

Viz strana 38 
 

 
  

  NEBO 

 
 
 
 
 
 
 
 
 
 

 

FAST 

Provedení 
kvantifikace – 
systém 7500 
Fast 

 
 
 

Nastavení teplotního 
profilu a spuštění běhu 
 
 
 
 
 
 

Řešení problémů 

 

 
 
 

 Viz strana 43 
 

5 
 

 
 
 
 
 Viz strana 48 

 

Analýza výsledků 
kvantifikace 
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 Dříve než začnete 

 
 
Dříve než začnete 

 
 

Ověřte, že na systému 7500 Fast je pravidelně prováděna kalibrace pozadí a kalibrace 
barev, takže je zajištěno jeho optimální fungování. Více informací o kalibraci systému 
7500 Fast naleznete v Nápovědě (Online Help) a v příručce Applied Biosystems 
7300/7500/7500 Fast Real-Time PCR System Installation and Maintenance Guide. 

 

Příprava PCR mastermixu 
 

Druhým krokem (PCR) dvoukrokové procedury RT-PCR je amplifikace cDNA, která 
se provádí pomocí mastermixu TaqMan® Universal PCR Master Mix. 

 

Uživatelé systémů 7300/7500 musí používat standardní TaqMan Universal PCR Master 

Mix (2×) s dobou trvání běhu 2 hod. Uživatelé systému 7500 Fast si mohou zvolit mezi 
mastermixem TaqMan Universal PCR Master Mix (2×) nebo TaqMan Fast Universal 

PCR Master Mix (2×) s dobou trvání běhu méně než 40 min. Více informací o používání 
mastermixu Fast naleznete v příručce  TaqMan Fast Universal PCR Master Mix Protocol 

(kat. č. 4351891). 
 
 

DŮLEŽITÉ!  Používáte-li mastermix TaqMan Fast Universal PCR Master Mix, musíte 
běh spustit do dvou hodin od přípravy destičky. Není-li běh zahájen do dvou hodin, lze 
destičku uložit do ledničky nebo zamrazit. 

 
Návod na používání reagencií, jež jsou součástí kitu, naleznete v protokolu TaqMan Fast 

Universal PCR Master Mix Protocol (kat. č. 4351891). V následující tabulce jsou uvede-
ny univerzální parametry experimentu (objem a výsledná koncentrace) za použití 
mastermixu. 

 
 

CHEMICKÉ RIZIKO. TaqMan Universal PCR Master Mix 
(2×) No AmpErase UNG může způsobit podráždění očí a kůže. Polknutí nebo inhalace 
může vést k nevolnosti.  Přečtěte si bezpečnostní list a dodržujte pokyny při manipulaci. 
Používejte prostředky ochrany očí, ochranný oděv a rukavice. 

 
 

 
Reagencie Objem (µL) / 

20-µL reakce 

TaqMan®  Gene Expression Assay Mix (20×): 
•   Forward PCR primer (18 µM) 

•   Reverzní PCR primer (18 µM) 
•   Sonda TaqMan® (5 µM) 

1.0 

cDNA templát (10 až 100 ng RNA přepsané do cDNA + voda prostá 
RNáz) 

9.0‡ 

TaqMan Fast Universal PCR Master Mix (2×), No AmpErase UNG 10.0 

Celkový objem 20.0 

‡   Používáte-li UNG, snižte objem cDNA templátu a vody prosté RNáz na 8.8 µL na 20-µL reakci a 
přidejte 0.2 µL UNG (1 U/µL). 

FFAASSTT 
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 FAST 

 
 
 
Příprava destičky 

 
 

Destičky Fast 
a standardní 

destičky  

DŮLEŽITÉ!  Ujistěte se, že na přístroji 7500 Fast používáte optické destičky typu Fast 
(Fast Optical 96-Well Plate). V 96-ti jamkovém bloku typu Fast nefungují standardní 
destičky správně a může dojít k jejich poškození. 

 

 
 

Destičky Fast Standardní destičky 
(kat. č. 4346906) (kat. č. 4306737) 

 
 

 
 
 
 

Šikmý roh 
vlevo nahoře 
(A1) 

Šikmý roh vpravo  
nahoře (A12) 

 

 
 
 
 
 

Maximální objem 
reakce 30-µL 

 

Maximální objem  
reakce 100-µL 

 
 
 

1.   Označte si destičku a ujistěte se, že máte pro každou detekovanou cílovou sekvenci 
připravenou sadu standardů. Standardy musí být na téže destičce.  

  
Poznámka:  Uspořádání reakcí na destičce (vzorky a eseje) by mělo odpovídat 
popisu (názvy vzorků a detektorů/markerů) v dokumentu destičky pro daný běh. 

 
 

2.  Pracujete-li se systémem 7500 Fast, pipetujte do každé jamky destičky 20 µL 
příslušného PCR mastermixu. 

 
Poznámka:  Reakce obsahující standardy připravujte naprosto totožným způsobem  
jako reakce obsahující neznámé vzorky. Používejte tytéž primery a sondy, složky  
PCR mastermixu a objem, ale do každého standardu přidejte známé množství  5 
templátu (jako je cDNA nebo plazmidová DNA). Všechny součásti před 
pipetováním do jamek destičky smíchejte. 

 
 

3.  Uzavřete destičku pomocí optické adhezívní fólie. 
 

4.  Krátce destičku centrifugujte. 
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 Příprava destičky 

 
 
 

5.  Ověřte, že se všechny reakce nacházejí na dně jamky. 
 

 
Správně Špatně 

 
 
 
 
 
 
 
 
 

Reakce je na dně jamky. Reakce je na boku jamky, 
protože destička nebyla 
centrifugována. 

Na dně jamky je vzduchová 
bublina – reakce nebyla 
centrifugována dostatečně 
dlouho nebo při dostateč- 
ných otáčkách. 

 
 
 

DŮLEŽITÉ!  Před spuštěním běhu se ujistěte, že se všechny reakce nacházejí na dně 
jamky. Není-li tomu tak, bude ovlivněna kvalita měření. 

 
 

6.   Destičku s reakcemi držte na ledu až do té doby, kdy jste připraveni ji umístit 
do přístroje. 

FFAASSTT 
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 FAST 

 
 
 
 

Vzorový pokus 
 

Při přípravě mastermixů pro PCR byly dodrženy univerzální reakční podmínky. 
 

 
Reagencie 

 
  µL/reakci 

 
µL/5 reakcí‡ 

 
µL/37 reakcí§ Výsledná 

koncentrace 

TaqMan Fast Universal PCR Master Mix 
(2×) 

10.0 50.0 370.0 1× 

TaqMan® Gene Expression Assay Mix (20×): 

•   Forward PCR primer (18 µM) 50 až 900 nM 

•   Reverzní PCR primer (18 µM) 50 až 900 nM 
•   Sonda TaqMan® (5 µM) 

 
 

Celkem 1.0 

 
 

Celkem 5.0 

 
 

Celkem 37.0 

50 až 250 nM 

Vzorek cDNA nebo templát standardu 10 až 100 ng 

Voda prostá nukleáz 

 
Celkem 9.0 

 
Celkem 45.0 

 
Celkem 333.0 

— 

Celkem 20.0 100.0 740.0 — 

‡   Pro každý z šesti standardů byl připraven jeden mastermix (4 replikáty a rezervní objem pro ztráty při pipetování). 
§   Pro každou z obou skupin (populací) vzorků byl připraven jeden mastermix (36 vzorků a rezervní objem pro ztráty při pipetování). 

 
Vzorky obsahující kvantifikovanou cílovou sekvenci i standardy byly uspořádány v destičce. Pro systém 7500 
Fast se pipetuje 20 µL odpovídajícího PCR mastermixu (včetně cDNA) do každé jamky. Destička byla až do 
vložení do systému 7500 Fast inkubována na ledu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

5 
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  Vytvoření dokumentu destičky pro absolutní kvantifikaci 

 
 
 
Vytvoření dokumentu destičky pro absolutní kvantifikaci 

 

 
    Přehled Dokument destičky pro absolutní kvantifikaci slouží k uchování dat z jednoho běhu, 

zároveň slouží k uchování dalších údajů o běhu jako jsou názvy vzorků a detektory. 
 

 
Nastavení 

běhu 
Pro každý vytvářený dokument destičky pro absolutní kvantifikaci musíte specifikovat 
detektory, standardy a úlohu detektoru (detector task): 
 

•   Detektor je virtuálně vyjádřená genově specifická kombinace primerů a sondy, které 
jsou používány v dané eseji. Pro každou detekovanou sekvenci vždy zadáváte 
detektor. Vytvoření detektorů je popsáno v Příloze A na straně 73. 

•   Standard je cílová sekvence o známém množství. Pro každou cílovou 
sekvenci používanou na destičce musíte mít sadu standardů. 

•   Úloha detektoru (detector task) udává, k čemu program používá data naměřená 
v průběhu analýzy. Každému detektoru je přiřazena jedna ze tří úloh. 

 

 
 Úloha Symbol Použijte pro detektory... 

 
Neznámý vzorek  V jamkách obsahujících cílovou kvantifikovanou sekvenci. 
(Unknown).  
 
Standard V jamkách obsahujících vzorky o známém množství. 
 

Netemplátová  V jamkách obsahujících PCR reagencie ale nikoliv templát (negativní kontrola)  
kontrola (No Temp- . 
late Control - NTC) 

  
 

FFAASSTT 
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Vytvoření dokumentu destičky pro absolutní kvantifikaci  
 

 
 
Vytvoření dokumentu destičky pro absolutní kvantifikaci 

 

Informace o vzorcích můžete do nového dokumentu 
destičky zadat, vložit pomocí kopírování z již 
existujících dokumentů destičky, importovat 
z existujících dokumentů destičky nebo definovat 
pomocí templátu. V této části je popsáno vytvoření 
nového dokumentu destičky prostřednictvím zadání 
údajů. Více informací o kopírování nebo importování 
informací o vzorcích z existujících dokumentů destiček 
nebo o používání templátů naleznete v Nápovědě. 

 
Poznámka:  Popsaný postup používá vzorová 
experimentální data (viz strana 7). 

 
 
Vytvoření nového dokumentu destičky: 

 
1.  Zvolte Start > All Programs > Applied 

Biosystems > 7300/7500 System > 7300/7500 
System Software ( ), čímž spustíte SDS 
software. 

 
2.  V okně Quick Startup document zvolte 

Create New Document (Vytvořit nový dokument). 
 
 
 
 
 
 
 
 
 
 
 
 

3. V rozbalovacím menu Assay (Esej) v okně New 
Document Wizard (Průvodce vytvořením nového 
dokumentu) zvolte Standard Curve (Absolute 
Quantitation) (Standardní křivka – Absolutní  

 kvantifikace). Použijte přednastavené možnosti   5 
 v nabídkách  Container (96-Well Clear – 96-ti 
 jamková destička) a Template (Templát) – Blank 
 document (Nevyplněný dokument). 

 
DŮLEŽITÉ!  Pro absolutní kvantifikaci 
nemůžete použít dokument typu RQ (Relativní 
kvantifikace) a opačně. 

 
 

4.  V poli Plate Name (Název destičky) zadejte název a klikněte Next > (Další). 

FFAASSTT 
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Vytvoření dokumentu destičky pro absolutní kvantifikaci 
 
 

5.  Zvolte detektory, které chcete přidat do dokumentu destičky. 
 

a.  Kliknutím označte detektor, např.  
RNase P (RNázaP). (Ctrl-klik zvolíte více  
detektorů.) Pokud ve Správci detektorů  
(Detector Manager) nejsou žádné detektory,  
klikněte na New Detector (Nový detektor),   5a 
čímž otevřete dialogové okno New Detector.  
Více informací o vytváření nových detektorů 5b 
naleznete v Příloze A na  straně 73. 

 

b.  Klikněte na Add >> (Přidat), čímž 
přidáte detektory do dokumentu 
destičky, následně klikněte na Next > 
(Další). 5b 

 

Poznámka:  Chcete-li odstranit detektor  
z okna Detectors in Document (Detektory  
v dokumentu), označte jej a klikněte 
Remove (Odstranit). 

 
 

6.  Pro každou jamku definujte detektory a jejich úlohu. 
 

a.  Označte jamku (nebo skupinu jamek,  
pro replikáty). 

b.  Klikněte na název detektoru(ů), čímž jej 
přiřadíte označené jamce. 

c.  Ve sloupci Task (Úloha) zvolte úlohu 
detektoru. 

d.  Pro jamky obsahující standardy 
zadejte jejich množství. 

 

e.  Klikněte Use (Použít). 

Úloha a barva detektoru se zobrazí ve 
zvolených jamkách. 

f.   Klikněte Finish (Ukončit). 6b 

Program SDS vytvoří dokument destičky. 6e 

 

6c 6d 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6a 
 

6f 

 

 FFAASSTT 
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Vytvoření dokumentu destičky pro absolutní kvantifikaci 

 
FAASSTT 

 
 
 

7.  Zadejte názvy vzorků. 
 

a.  Klikněte na   nebo zvolte View > Well  
Inspector (Zobrazit > Prohlížeč jamek). 

 
Poznámka:  Názvy vzorků lze zadat i tak, že 
označíte vybrané jamky a napíšete název. 

 
 

b.  Klikněte na jamku nebo označte více jamek. 
 

c.  Zadejte název vzorku. 
 

d.  Je-li zapotřebí, změňte zvolenou 
Pasivní referenci. (Přednastavena je 
barva ROX™.) 

 

e.  Opakujte kroky b až d tak dlouho, až zadáte 
názvy vzorků a definujete pasivní referenci 
pro všechny jamky na destičce, poté klikněte 
na ( ), čímž okno Well Inspector uzavřete. 

 
Poznámka:  Zadané informace (název 
vzorku, detektor, úloha detektoru) můžete 
změnit po skončení běhu. 

 

5K 
 

 
 
 
 
 
 
 
 
7b 7c 7d 7e 

 
 
 

DŮLEŽITÉ!  Pokud v pokusu nepoužíváte 
všechny jamky destičky, nevyřazujte je nyní 
z analýzy (pomocí funkce Omit - Vypustit). 
Můžete tak učinit až po skončení běhu. Více 
informací naleznete v  nápovědě . 

 
 

8.  V záložce Setup (Nastavení) ověřte, že jste 
všechny informace zadali správně. 

 

 
 
 

5 
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Vytvoření dokumentu destičky pro absolutní kvantifikaci 
 
 
 

Vzorový pokus 
 

Kvantifikované vzorky i standardy byly uspořádány na jedinou destičku. Každé jamce byl přiřazen detektor 
(symbol barevného čtverečku). Každé jamce byla rovněž přiřazena úloha detektoru — U (unknown – Neznámý vzorek), 
S (standard) nebo N (no template control – netemplátová kontrola). 

 

Jelikož byl kvantifikován pouze jeden gen, byl definován pouze jediný detektor (nazvaný RNase P – RNáza P). 
 

Obrázek níže znázorňuje vzorový dokument destičky pro absolutní kvantifikaci poté, co byly zadány názvy vzorků, detektor 
a úlohy detektoru pro každou jamku 

 
 
 
 
 
 

Název vzorku 
 
 

Úloha detektoru a 
barva 

 FFAASSTT 
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Nastavení teplotního profilu a spuštění běhu 

 
FAASSTT 

 

Nastavení teplotního profilu a spuštění běhu 
 

Teplotní profil 
typu Fast 
(Rychlý) 

•   Optimální fungování režimu rychlého cyklování (Fast mode) a mastermixu TaqMan 
Fast Universal PCR Master Mix (2×), No AmpErase UNG bylo ověřeno pouze pro 
provádění kvantifikace a nikoliv pro reakce s analýzou prováděnou až po jejich 
skončení (tzv. endpoint) jako např. alelická diskriminace. 

•   Optimální fungování přednastaveného režimu rychlého cyklování (Fast 
mode) a mastermixu TaqMan Fast Universal PCR Master Mix (2×), No 
AmpErase UNG bylo ověřeno pro TaqMan Gene Expression Assays 
(TaqMan® eseje pro kvantifikaci genové exprese) a Custom TaqMan® Gene 
Expression Assays (TaqMan® eseje pro kvantifikaci genové exprese – na 
objednávku) společnosti Applied Biosystems. 

•   Pro většinu kvantifikačních esejí, navržených podle doporučení (Assay Design 
Guidelines) společnosti Applied Biosystems, získáte při použití 
přednastaveného režimu rychlého cyklování (Fast mode) a mastermixu 
TaqMan Fast Universal PCR Master Mix (2×), No AmpErase UNG srovnatelné 
výsledky, jako při použití standardního režimu cyklování a mastermixu 
TaqMan® 2× Universal PCR Master Mix. Pokud nikoliv, postupujte podle části 
“Řešení problémů” na straně 48. 

•   Provádíte-li multiplex PCR (v jedné zkumavce je amplifikována více než 
jedna cílová sekvence), je možné, že bude nutné esej optimalizovat. Před 
prováděním multiplex PCR si přečtěte informace na straně 48 v části 
Řešení problémů. 

 
Expertní režim Expertní režim (Expert mode) vám umožňuje provádět měření při použití pouze těch  
(Expert Mode) filtrů, které jsou ve vámi prováděném pokusu zapotřebí, což zkracuje dobu trvání běhu na 

méně než 30 minut. Je zapotřebí dodržovat následující doporučení. Více informací 
naleznete v příručce Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System 

Using Expert Mode User Bulletin: 
 

•   V přednastaveném teplotním profilu v rychlém režimu (Fast mode) je nastavena doba 
polymerace 30 vteřin. Možnost použití této doby polymerace byla ověřena pro 
TaqMan Gene Expression Assays (TaqMan® eseje pro kvantifikaci genové exprese), 
TaqMan Pre-Developed Assay Reagents (reagencie pro TaqMan® eseje) a eseje 
navržené pomocí programu Primer Express za použití přednastaveného režimu 
rychlého cyklování (Fast mode). 

•   Použití kratší doby polymerace než 30 vteřin má vliv na fungování některých esejí. 

Chcete-li použít kratší dobu, musíte toto použití validovat pro vámi používanou esej.  5 

•   Společnost Applied Biosystems důrazně doporučuje používání barvy ROX™ pro 
normalizaci fluktuací vzniklých v důsledku nepřesného pipetování. 

•   Používáte-li pasivní referenci ROX, musíte zvolit oba filtry FAM™ a ROX.  

•   Používáte-li více než tři filtry, prodlužte dobu polymerace (delší doba trvání 
měření fluorescence). 

 
Poznámka:  Filtry jsou označeny A až E, ale můžete je přejmenovat. Zvolte Tools > 
Filter Configuration (Nástroje > Nastavení filtrů), čímž otevřete okno Filter Naming 
(Názvy filtrů). 
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 Nastavení teplotního profilu a spuštění běhu 

 
 
 

Přednastavený 
teplotní profil pro 

PCR 

Pokud jste si pro váš pokus absolutní kvantifikace zvolili dvoukrokovou RT-PCR 
(doporučeno), již jste provedli krok reverzní transkripce. Nyní provedete amplifikaci DNA 
pomocí PCR. Uživatelé systému 7500 Fast si mohou zvolit mezi přednastaveným 
standardním režimem cyklování a režimem rychlého cyklování (Fast mode). Expertní 
režim je nastavený jako vypnutý a lze jej zapnout pouze pro režim rychlého cyklování. 
 

 
 

V záložce Instrument (Přístroj) se zobrazí přednastavený teplotní profil PCR, viz 
následující tabulka. 

 

Časy a teploty Fast (Dvoukroková RT-PCR) 

HOLD (Inkubace) HOLD (Inkubace) HOLD (Inkubace)  
1) RT 

10 min při 25 °C 120 min při 37 °C 5 sec při 85 °C 

Teplotní profil Fast (pouze systém 7500 Fast) 

2) PCR  Aktivace enzymu Denaturace Annealing/Polymerace 

Režim Fast 20 sec při 95 °C 3 sec při 95 °C 30 sec při 60 °C 

Expertní režim 20 sec při 95 °C 3 sec při 95 °C 20 sec při 60 °C 
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Nastavení teplotního profilu a spuštění běhu 

 
 
 
Teplotní profil nastavíte a běh spustíte takto: 

 
1.  Zvolte záložku Instrument (Přístroj). 

 

Zobrazí se přednastavený teplotní profil 
(standardní podmínky pro dvoukrokovou RT-
PCR). 

 
2.  Ověřte, že: 

•   Používáte-li dvoukrokovou RT-PCR – Je 
nastaven přednastavený teplotní profil PCR. 

 
Poznámka: Používáte-li jednokrokovou  
RT-PCR, použijte teplotní profil uvedený 
v části “Teplotní profil pro jednokrokovou  
RT-PCR” na straně 44. 

 
 
 

•   Objem vzorku je 20 µL (pro 7500 Fast). 

•   Je nastaven Run Mode (Režim běhu) Fast 7500. 
 

Poznámka:  Používáte-li chemizmus SYBR® 

Green I a chcete ověřit přítomnost kontaminací 
či stanovit disociační teplotu vašich amplikonů, 
klikněte na Add Dissociation Stage (Přidat 
krok disociace). Tento krok zahrnuje i 
ochlazení po skončení disociační analýzy. Více 
informací naleznete v  nápovědě. Uživatelé 
systému 7500 Fast mohou používat chemizmus 
SYBR Green I v režimu běhu Standard nebo 
9600 Emulation. 

 
 
 

DŮLEŽITÉ!  Chcete-li použít Expertní režim,  
pokračujte krokem 3. Jinak pokračujte krokem 6. 

 
3.  Zatrhněte políčko Expert Mode (Expertní režim). 

 

 4.  Zvolte tlačítko Select/View Filters (Výběr filtrů). 5 
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 Nastavení teplotního profilu a spuštění běhu 

 
 
 

5.  Vyberte filtry pro měření a potvrďte OK. Filtr 
zvolíte zatržením okénka vedle názvu filtru. 

 
DŮLEŽITÉ!  Není-li zvolen žádný filtr, nebudou 
provedena žádná měření. 

 
 
 

Poznámka:  Důrazně se doporučuje používání 
barvy ROX™ pro normalizaci fluktuací 
vzniklých v důsledku nepřesného pipetování. Je 
nutné zvolit filtry FAM a ROX, aby byla 
excitována i pasivní reference ROX 
v mastermixu společnosti Applied Biosystems. 

 
 
 

Poznámka:  Informace o možnosti jak změnit 
názvy filtrů naleznete v  nápovědě nebo příručce 
Applied Biosystems 7500 Fast Real-Time PCR 

System Using Expert Mode User Bulletin. 
 
 

6.   Zvolte File > Save (Soubor > Uložit), zadejte 
název dokumentu destičky a klikněte Save 
(Uložit). 

 

(Volitelné) Chcete-li tento dokument destičky 
použít znovu, uložte jej jako templát. Zvolte File 
> Save As (Soubor > Uložit jako). 
V rozbalovacím menu Save in (Uložit v) 
vyhledejte adresář Applied Biosystems\ 
7300\7500\7500 Fast System\Templates 
(Templáty). Zadejte název souboru, zvolte typ 
souboru (*.sdt) v Save as type (Uložit jako typ) a 
uložte soubor jako templát. 

 
7.   Vložte destičku do zásuvky přístroje. Ujistěte 

se, že destička je vložena do přístroje ve správné 
orientaci. 

 
Poznámka:  Pozice A1 musí být v levém 
horním rohu zásuvky přístroje. Čárový kód je

 

 
 

1         2         3         4         5         6         7         8         9        10       11       12 

A 

B 

C 

D 

E F 

G 

směrován k čelní straně přístroje. A1 1 

 A 
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Nastavení teplotního profilu a spuštění běhu   
 
 

8.  Klikněte Start. 
 

Během provádění PCR zobrazuje přístroj 
v záložce Instrument (Přístroj) informace 
v reálném čase a udává naměřené hodnoty 
fluorescence. 

 

Po skončení běhu jsou stavové hodnoty a tlačítka 
šedá a tlačítko Analysis (Analýza)  je aktivní. 
Současně se objeví zpráva oznamující úspěšné či 
neúspěšné ukončení běhu. 

 

Veškerá data vytvořená v průběhu běhu jsou 
uložena do dokumentu destičky tak jak byl zadán 
v kroku 6. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 
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 Řešení problémů 

 
 
 
Řešení problémů 

 
 
Řešení problémů  

 

Problém 
 

Možná příčina 

 
 
 

Nápravné kroky 

Cílová sekvence se obtížně 
amplifikuje 

•   Prodloužení doby annealingu/ 
polymerace v režimu cyklování. 

•   Zvýšení teploty annealingu/ 
polymerace na 62 °C. 

Nedostatečné množství cDNA Použijte 10 až 100 ng cDNA 
templátu na 20-µL reakci. 

Nízká kvalita cDNA 1.  Proveďte kvantifikaci cDNA. 
 

2.  Ověřte přítomnost inhibitorů 
v cDNA templátu. 

 

 3.  Ověřte, že je OD260/280 > 1.8 pro 
RNA nebo 1.9 pro DNA. 

Degradace vzorku Zopakujte pokus s čerstvě 
připravenou cDNA. 

Použili jste TaqMan Universal PCR 
Master Mix (2×) namísto TaqMan 
Fast Universal PCR Master 
Mix (2×), No AmpErase UNG 

Proveďte reakce za použití 
správného mastermixu. 

Vysoké hodnoty CT /nízká 
přesnost nebo nezdařené PCR 
reakce 

Tvorba dimerů primerů. Pro dosažení optimálních výsledků je 
nutné spustit reakce co nejdříve po 
jejich přípravě. Není-li možné reakce 
spustit do 2 hodin od ukončení jejich 
přípravy, umístěte destičku s 
reakcemi do lednice nebo ji zamrazte 
do té doby, než je možné ji 
analyzovat na přístroji 7500 Fast. 

Příliš krátká doba polymerace Použijte přednastavený 
teplotní profil (viz strana 44). 

Nízké hodnoty ∆Rn nebo Rn  

Tvorba dimerů primerů. Pro dosažení optimálních výsledků je 
nutné spustit reakce co nejdříve po 
jejich přípravě. Není-li možné reakce 
spustit do 2 hodin od ukončení jejich 
přípravy, umístěte destičku s 
reakcemi do lednice nebo ji zamrazte 
do té doby, než je možné ji 
analyzovat na přístroji 7500 Fast. 
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Řešení problémů  

 

Problém 
 

Možná příčina 

 
 
 

Nápravné kroky 

Běh trvá déle než 40 minut Je nastaven režim cyklování 
Standard nebo 9600 Emulation 

Nastavte rychlý režim cyklování – 
Fast mode (viz strana 44). 

Graf závislosti Rn na cyklu se 
nezobrazí 

Při nastavení běhu nebyla zvolena 
barva ROX™ jako pasivní reference  

Při nastavení běhu zvolte barvu ROX 

jako pasivní referenci. 

Při nastavení běhu nebyla zvolena 
barva ROX jako pasivní reference  

Při nastavení běhu zvolte barvu ROX 

jako pasivní referenci. 
Příliš vysoké hodnoty ∆Rn nebo Rn   

Evaporace Ujistěte se, že destička je dokonale 
uzavřena, zejména v rozích. 

Při nastavení běhu nebyla zvolena 
barva ROX jako pasivní reference  

Při nastavení běhu zvolte barvu ROX 

jako pasivní referenci. 
Vysoká variabilita v reakční 
destičce 

Evaporace Ujistěte se, že destička je dokonale 
uzavřena, zejména v rozích. 

Vysoká variabilita replikátů Nedokonalé promíchání reakčního 
mixu 

Promíchejte reakční mix 
několikrát opatrným otočením, 
před rozplněním do destičky 
krátce centrifugujte.  

 

 
 
 

Multiplex PCR – Řešení problémů 
 

DŮLEŽITÉ!  S ohledem na složitost multiplex PCR a její komplexní charakter je nemožné v multiplexním uspořádání 
garantovat optimální průběh esejí. Společnost Applied Biosystems doporučuje při provádění multiplexních aplikací za 
použití rychlého režimu cyklování a mastermixu TaqMan Fast Universal PCR Master Mix (2×), No AmpErase UNG 
provedení níže uvedených kroků, a to v pořadí, v jakém jsou uvedeny. 

Při provádění multiplex PCR: 
 

1.  Zvyšte teplotu annealingu/polymerace na 62 °C.   5 

2.  Pokud ani po zvýšení teploty annealingu/polymerace na 62 °C nefungují eseje optimálně, prodlužte dobu 
annealingu/ polymerace o 5 vteřin na 35 vteřin. 

 

3.  Pokud ani po zvýšení teploty či prodloužení doby annealingu/polymerace nefungují eseje optimálně, je možné, že 
bude nutné je znovu optimalizovat. Více informací naleznete v příručce Real-Time PCR Systems Chemistry Guide 
(kat. č. 4348358). 
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Nastavení parametrů analýzy 
 
 
 

Nastavení parametrů analýzy 
 
Před vlastní analýzou dat musíte nastavit 
parametry této analýzy. 

 

Pokud jste pro váš pokus dosud nestanovili 
optimální nastavení pozadí (baseline) a prahu 
(threshold), použijte automatické nastavení těchto 
parametrů, které je k dispozici v programu SDS 
(Auto Ct). Bylo-li nastavení pozadí a prahu 
provedeno správně pro všechny jamky, pokračujte 
zobrazením výsledků. Pokud nikoliv, musíte 
nastavení pozadí a prahu provést ručně, viz část 
“Ruční nastavení pozadí a prahu” na straně 54. Níže 
je popsáno použití funkce automatického nastavení 
(auto Ct). 

 

Chcete-li nastavit parametry analýzy: 
 

1.   Klikněte   nebo Analysis > Analysis Settings 
(Analýza > Parametry analýzy). 

 
2.  V rozbalovacím menu Detectors (Detektory) 

zvolte All (Všechny).  2 

3.  Zvolte funkci Auto Ct. Program SDS nastaví 3 
automaticky pozadí pro každou jamku a   
práh pro každý detektor. 

 
DŮLEŽITÉ!  Po provedení analýzy musíte 
ověřit, že pozadí a práh byly pro každou jamku 
nastaveny správně, jak je popsáno v části 
“Nastavení pozadí a prahu” na straně 54. 4 
 

5 

Případně můžete zvolit Manual Ct (Ruční 
nastavení prahu) a provést nastavení prahu a 
pozadí ručně. Rovněž je možné zvolit funkci 
Auto baseline (Automatické nastavení pozadí) 
a Manual Ct (Ruční nastavení prahu). 
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Nastavení parametrů analýzy 

 
 
 

4.   (Volitelné) Zvolte Use System Calibration 
(Použít soubory kalibrace systému), čímž 
použijete kalibrační soubory uložené v počítači, 
který právě používáte. 

 
Poznámka:  Nezvolíte-li možnost Use System 
Calibration, budou použity kalibrační soubory 
uložené v dokumentu vaší destičky. Tyto 
soubory pocházejí z počítače, který byl připojen 
k Real-Time PCR cykleru v okamžiku analýzy 
destičky. 

 
 

Více informací o souborech kalibrace systému 
naleznete v  nápovědě. 

 
5.  Klikněte OK & Reanalyze (OK & Analyzovat znovu). 

 
6.  Zkontrolujte graf amplifikace a v případě potřeby 

upravte ručně nastavení pozadí a prahu tak jak je 
popsáno v následující části. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6 



Kapitola 6  Analýza výsledků kvantifikace 

Poznámky    
  
  

 

54 Absolutní kvantifikace pomocí standardní křivky – Uživatelská příručka pro systémy 7300/7500/7500 Fast  

  

 

                                   

 

Nastavení pozadí a prahu 
 
 
 

Nastavení pozadí a prahu 
 
 

Automatické 
nastavení 

pozadí a prahu 

Funkce programu SDS Manual Ct (Ruční nastavení prahu) vypočítává pozadí a práh pro 
každý detektor na základě předpokladu, že výsledkem amplifikace je “typický” průběh 
křivek. 
 
 

a 

b 
 
 

∆Rn 

Práh (Threshold)  
c 

 
 
 
 

d 
 
 
 
 
 

e 
Cyklus 

 
Typická amplifikační křivka má: 

 

•   Fázi plató (Plateau) (a) 

•   Fázi lineární (b) 

•   Fázi exponenciální (geometrickou) (c) 

•   Pozadí (Background) (d) 

•   Pozadí (Baseline) (e) 
 

Experimentální chyby (jako např. kontaminace, chyby při pipetování apod.) mohou 
vést k výsledkům, které se od typického průběhu amplifikačních křivek výrazně liší. 
Takové výsledky pak vedou k tomu, že softwarový algoritmus nastaví pozadí a práh 
pro daný detektor nesprávně. 
 

Společnost Applied Biosystems proto doporučuje, abyste po provedení analýzy provedli 
kontrolu nastavení pozadí a prahu pro všechny detektory. Je-li to nezbytné, nastavte tyto 
parametry ručně jak je popsáno na straně 57. 

 

 
Ruční nastavení 
pozadí a prahu 

Pokud jste pro některý z detektorů provedli nastavení pozadí a prahu ručně, proveďte pro 
každý detektor kroky popsané na straně 57. 
 

Na následujících amplifikačních grafech je demonstrován vliv nastavení pozadí a prahu. 
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 Nastavení pozadí a prahu 

 
 
 
 

Správné nastavení pozadí (Baseline) 
 

Amplifikační křivka začíná až po ukončení fáze 
pozadí. Práh je nastaven v exponenciální fázi 
amplifikační křivky. Žádné korekce nastavení 
nejsou nutné. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Nízké nastavení pozadí (Baseline) 
 

Amplifikační křivka začíná příliš daleko (vpravo) 
od maxima pozadí. Zvyšte nastavení End Cycle 
(Konečný cyklus). 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Vysoké nastavení pozadí 
 

Amplifikační křivka začíná před maximem pozadí. 
Snižte nastavení End Cycle (Konečný cyklus). 
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Nastavení pozadí a prahu 
 
 
 
 

Správné nastavení prahu (Threshold) 
 

Práh je nastaven v exponenciální fázi amplifikační 
křivky. 

 

Změna nastavení prahu mimo tuto optimální 
hodnotu se projeví vyšší standardní odchylkou 
skupiny replikátů. 

 
 
 
 
 
 
 
 
 

Nízké nastavení prahu (Threshold) 
 

Práh je nastaven před započetím exponenciální 
fáze amplifikační křivky. Standardní odchylka má 
výrazně vyšší hodnotu než při správném nastavení 
prahu. Posuňte práh nahoru do exponenciální fáze 
křivky. 

 

 
 
 
 
 
 
 
 
 

Vysoké nastavení prahu (Threshold) 
 

Práh je nastaven až po skončení exponenciální fáze 
amplifikační křivky. Standardní odchylka má 
výrazně vyšší hodnotu než při správném nastavení 
prahu. Posuňte práh dolů do exponenciální fáze 
křivky. 

Nahoru 

Dolů 
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 Nastavení pozadí a prahu 

 
 
 
 
 
 

1 
 

 
3 

 
Exponenciální fáze 
amplifikační křivky 

 
 

5a 
 

5b 
 

4a 

 
4b 

 
 
 
 
 
 
 

2 
 
 
 
 

Chcete-li ručně nastavit pozadí a práh: 
 

1.  Zvolte záložku Amplification Plot (Amplifikační graf), následně zvolte 
v rozbalovacím menu Data Delta Rn vs Cycle (Graf závislosti Delta Rn na 
cyklu). 

 
2.  Zvolte jamky, které chcete zobrazit. (Jinak zůstane graf prázdný.) 

 
3.  V rozbalovacím menu Detector (Detektor) zvolte detektor. Program SDS zobrazí 

graf pro zvolený detektor a jamky. 
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Nastavení pozadí a prahu 
 
 
 

4.  Nastavte pozadí pro daný detektor. 
 

a.  V části Analysis Settings (Parametry analýzy)  
zvolte Manual Baseline (Ruční nastavení 
pozadí). 

 

b.  Zadejte údaje do polí Start (cycle) a End 
(cycle) (Počáteční a konečný cyklus) tak, aby 
amplifikační křivka začínala v cyklu po 
nastavené hodnotě End Cycle (Konečný 
cyklus). 

 
Poznámka:  Jakmile změníte nastavení 
pozadí nebo prahu pro daný detektor, 
tlačítko  (Analýza) bude aktivní, 
čímž je indikována nutnost provést 
opakovanou analýzu dat. 

 
 

5.  Nastavte práh pro daný detektor. 
 

a.  V části Analysis Settings (Parametry 
analýzy), zvolte Manual Ct (Ruční 
nastavení prahu). 

 

b.  Potažením nastavte práh tak, aby byl: 

•   nad úrovní pozadí 

•   pod plató fází a lineární fází 
amplifikační křivky 

•   v exponenciální fázi amplifikační 
křivky 

Program SDS upraví hodnotu prahu a po 
analýze ji zobrazí v poli Threshold (Práh). 

 
6.  Zopakujte kroky 3 až 4 - proveďte nastavení 

pozadí a prahu pro každý použitý detektor. 
 

7.  Klikněte Analysis > Analyze (Analýza > Provést 
analýzu) čímž zopakujete analýzu s nově 
nastavenými hodnotami pozadí a prahu. 

 
Posuňte nastavení prahu. Linka 
zčervená, což je indikace toho, že 
jste změnili nastavení. 

Tlačítko Analyze 
(Analýza) bude po 
změně nastavení 
pozadí nebo prahu 
aktivní. 
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 Nastavení pozadí a prahu 

 
 
 
 

Vzorový pokus 
 

Výsledky byly nejprve analyzovány pomocí funkce automatického nastavení Ct (Auto Ct) a pozadí (Auto Baseline). 
Výsledkem byl tento amplifikační graf: 

 

 
Po bližším prostudování je zřejmé, že nastavení pozadí a prahu je v pořádku a nevyžaduje dalších úprav: 

 

•   Amplifikační křivka začíná až po konečném cyklu nastavení pozadí (baseline). 

•   Práh je položen v exponenciální fázi amplifikační křivky. 
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Analýza a zobrazení výsledků 
 
 

Záložka 
Results 

(Výsledky) 

V záložce Results (Výsledky) jsou zobrazeny výsledky běhu a je možné zde měnit 
nastavení. Např. je možné vypustit z analýzy některé vzorky nebo ručně nastavit pozadí a 
práh. Změníte-li nastavení, musíte výsledky analyzovat znovu. 
 

 
 

V záložce Results (Výsledky) je několik dalších záložek, které jsou popsány níže. 
Detailní popis je v  nápovědě. 
 

•   Chcete-li se posunout na další záložku, klikněte na tabelátor. 

•   Chcete-li zvolit všech 96 jamek destičky, klikněte do jejího levého horního rohu. 
 

 

•   Chcete-li změnit způsob jak je zobrazen graf, poklepejte na osu y nebo x, čímž 
zobrazíte okno Graph Settings (Nastavení grafu). Podle typu grafu můžete změnit 
některá jeho nastavení. 
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 Analýza a zobrazení výsledků 

 
 
 

Záložka Plate Pro každou destičku zobrazuje tyto výsledky: 
 

(Destička) •   Název vzorku a úlohu a barvu detektoru pro každou jamku. 

•   Vypočítané množství (přednastaveno), ∆Rn nebo Ct. Zvolte Analysis > Display 
(Analýza > Zobrazení), chcete-li změnit zobrazovaný údaj. 

 
Poznámka:  Pro detektory, pro něž nebyly definovány standardy, se v záložce Plate 
(Destička) zobrazuje “Undet.” (undetermined - nestanoveno). 

 
 

 
 

Záložka Spectra Zobrazuje fluorescenční spektra zvolených jamek. 
 (Spektra)  

•   Posuvník Cycle (cyklus) vám umožňuje zobrazit spektra pro každý jednotlivý 
cyklus. 

•   V poli Cycle # (Cyklus) se zobrazuje aktuální pozice posuvníku. 
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Záložka Component Pro jednotlivé jamky a celý průběh PCR zobrazuje příspěvek signálu každé použité barvy  
 (Komponenty) do celkového spektra. Zobrazuje se vždy pouze jediná jamka. 

 

 
 

Poznámka:  Používáte-li produkty TaqMan®, zobrazují se v této záložce signály tří 
komponent (barva ROX™, reportérová barva a barva TAMRA™ -zhášeč). Používáte-li 
produkty TaqMan® MGB, zobrazují se pouze signály dvou komponent (ROX a 
reportérové barvy). 

 

 
Záložka 

Amplification 
(Amplifikace) 

Pro zvolené vzorky je možné zobrazit tři různé amplifikační grafy. V těchto grafech se 
zobrazují všechny vzorky ze zvolených jamek. 
 
Zobrazení Rn vs. Cycle (Lineární) – Graf závislosti Rn na cyklu 
 

Zobrazuje závislost normalizované fluorescence reportérové barvy (Rn) na cyklu. Tento 
graf můžete použít, chcete-li prostudovat, zda průběh amplifikačních křivek není 
atypický. 
 

 

Více informací o parametru Rn naleznete v příručce Real-Time PCR Systems Chemistry 

Guide. 
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 Analýza a zobrazení výsledků 

 

 
 
 

Zobrazení ∆Rn vs.Cycle (Logaritmické) – Graf závislosti ∆Rn na cyklu 
 

Zobrazuje závislost fluorescence barvy (∆Rn) na cyklu. Tento graf můžete použít, chcete-
li prostudovat, zda průběh amplifikačních křivek není atypický, a pro ruční nastavení 
prahu a pozadí pro daný běh. 

 

 
 

Zobrazení Ct vs. Well Position – Graf závislosti hodnoty Ct na pozici jamky 
 

Zobrazuje hodnotu prahového cyklu (CT) pro každou jamku. Tento graf můžete 
použít, chcete-li pro daný detektor vyhledat odlehlé body (outliers) (viz “Vynechání 
vzorků” na straně 66). 
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Standardní křivka Zobrazuje standardní křivku, vytvořenou na základě vzorků, označených jako standardy. 
 

Program SDS vypočítává množství kvantifikované cílové sekvence ze standardní křivky 
pro detektor této cílové sekvence. 

 

 
 

Disociační křivka Zobrazuje křivky teploty tání (Tm). Tyto křivky jsou zobrazeny při použití barvy 
SYBR® Green pokud: 

 

•   V záložce Instrument (Přístroj) bylo zvoleno provedení disociační křivky  

•   Jako esej byla zvolena disociace (Dissociation) 
 

 
 

Analýza disociační křivky je popsána v Příloze C na straně 77 a v  nápovědě. 



Kapitola 6  Analýza výsledků kvantifikace 

Poznámky    
  
  

 

Absolutní kvantifikace pomocí standardní křivky – Uživatelská příručka pro systémy 7300/7500/7500 Fast 65 

  

  

                                   
 Analýza a zobrazení výsledků 

 
 
 

Report (Zpráva) Pro zvolené jamky zobrazuje v tabulce uspořádané výsledky. To jaké sloupce jsou 
zobrazeny je dáno typem eseje. Při provádění absolutní kvantifikace se zobrazují 
následující sloupce: Well (Jamka), Sample Name (Název vzorku), Detector (Detektor), 
Task (Úloha detektoru), Ct, StdDev Ct (Standardní odchylka Ct), Quantity (Množství), 
Mean Qty (Průměrné množství), StdDev Qty (Standardní odchylka množství), Filtered 
(Chybové hlášky analýzy), Tm a tři uživatelsky nastavitelné sloupce (jejich nastavení je 
popsáno v  nápovědě). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Poznámka:  Chcete-li výsledky uspořádat podle některého ze sloupců, klikněte do jeho 
záhlaví (první kliknutí – uspořádání od A do Z, druhé kliknutí – uspořádání od Z do A). 

 
 

V dialogovém okně Report Settings (Nastavení zprávy) můžete zvolit způsob zobrazení 
výsledků a vytištění zprávy. Tato nastavení lze použít i v případě exportu výsledků (viz 
“Export výsledků absolutní kvantifikace” na straně 70). Více informací o tomto 
dialogovém okně naleznete v  nápovědě. 

 
 
 
 
 
 
 
 
 
 
 

Více možností nastavení 
se zobrazí po kliknutí na 
Choose Data Columns 
and Ordering (Volba 
sloupců a jejich 
uspořádání). 
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Vynechání vzorků 
 
 
 

Vynechání vzorků 
 

V důsledku experimentální chyby je možné, že 
některé jamky budou amplifikovány nedostatečně a 
nebo vůbec. V takových jamkách pak získáte CT 

hodnoty, které se výrazně liší od průměru dané 
skupiny replikátů. Pokud je zahrnete do výpočtu, 
mohou tyto odlehlé body (outliers) vést ke 
zkreslení výsledků měření. 

 

Chcete-li dosáhnout maximální přesnosti, pečlivě 
zkontrolujte, zda v dané skupině replikátů není 
nějaký odlehlý bod. Tyto odlehlé body můžete z 
analýzy odstranit v amplifikačním grafu CT vs. Well 
Position – Graf závislosti hodnoty CT na pozici 
jamky nebo v grafickém vyobrazení standardní 
křivky. 

 
Vynechání odlehlých bodů v amplifikačním grafu 

 
1. Zvolte záložku Amplification Plot (Amplifikační  

graf). 
 

2.  V rozbalovacím menu Data zvolte Ct vs Well 
Position (Graf závislosti hodnoty CT na pozici 
jamky). 

 
3.  Označte jamky a porovnejte CT hodnoty 

pro každou skupinu replikátů. 
 

4.  Naleznete-li odlehlý bod, vyhledejte 
odpovídající jamku: 

 

a.  Na ose x odečtěte o jakou jamku se přibližně 
jedná. 

 
Odlehlý bod 

 
 
 
 
 
 
 

4a 
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Vynechání vzorků 
 

 
 
 

b.  Ve vyobrazení destičky označte několik 
jamek v rozsahu, který zahrnuje i přibližně 
definovanou jamku. 

V grafu se zobrazí pouze označené jamky. 
 

c.  V grafu stanovte o jakou jamku 
(odpovídající odlehlému bodu) se 
přesně jedná. 

 
 
 
Odlehlý bod 

 
 
 
 
 
 
 
 
 
 
 

4b 4c 
 
 

d.  Zvolte View > Well Inspector (Zobrazit > 
Prohlížeč jamek), následně pro danou 
jamku zatrhněte políčko Omit Well 
(Vynechat jamku). 

 
 
Odlehlý 
bod 
v grafu 

 

 
 
 
 

Zatrhněte  
políčko  
Omit Well 
(Vynechat 
jamku) 

 
 

Vynechaná 
jamka je 
označena 
křížem 
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Vynechání vzorků 
 
 
 

5.   Klikněte   nebo Analysis > Analyze 
(Analýza > Parametry analýzy), čímž 
zopakujete analýzu bez vynechané jamky. 

 
6.  Opakujte kroky 4 a 5 i pro další jamky dle vaší 

volby. 

 
 
 
Odlehlý bod odstraněn 
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Vynechání vzorků 

 
 
 
Odstranění odlehlých bodů standardní křivky 

 
1.  Zvolte záložku Standard Curve (Standardní křivka). 

 
2.  Ve vyobrazení destičky označte všechny jamky. 

 
3.  Vyhledejte odlehlé body. 

 
  
Poznámka:  Chcete-li zobrazení zvětšit, klikněte na 

 (Zoom In), následně klikněte do grafu 
standardní křivky (nebo kliknutím označte skupinu 
jamek). 

 
 

4.  Naleznete-li odlehlý bod, klikněte  (Select - 
Zvolit), následně klikněte na tento odlehlý bod, 
čímž označíte příslušnou jamku (nebo kliknutím 
označte skupinu jamek). 

 
5.   Klikněte Omit Wells (Vynechat jamky) (nebo 

klikněte pravým tlačítkem myši a zvolte Omit 
Wells – Vynechat jamky). 

 
6.  Klikněte   nebo Analysis > Analyze 

(Analýza > Parametry analýzy), čímž 
zopakujete analýzu bez odlehlého bodu. 

 
7.  Opakujte kroky 4 až 6 pro další odlehlé body, 

které chcete odstranit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6 
Označené jamky 4 5 
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Export výsledků absolutní kvantifikace 

 
 
 

Export výsledků absolutní kvantifikace 
 
Číselné údaje můžete exportovat ve formě textových 
souborů, které lze následně importovat do tabulkových 
editorů jako např. Microsoft® Excel®. Grafy lze 
exportovat ve formátu prezentací pro Microsoft® 

PowerPoint® nebo ve formátu JPEG. 
 
 

Poznámka:  Chcete-li exportovat grafy do programu 
PowerPoint, musíte mít tento program instalován. 

 
 

Export dat do tabulkového editoru: 
 

1.  Zvolte File > Export (Soubor > Export), následně 
zvolte, co chcete exportovat. 

•   Sample Setup (*.txt) – Popis vzorků 

•   Calibration Data (*.csv) – Kalibrační údaje 

•   Spectra (*.csv) - Spektra 

•   Component (*.csv) - Komponenty 

•   Delta Rn (*.csv) 

•   Ct (*.csv) 

•   Dissociation (*.csv) - Disociace 

•   Results - Výsledky 
 

Více informací o typech souborů pro export dat 
naleznete v  nápovědě. 

 
2.  Zadejte název exportovaného souboru. 

 
3.  Klikněte Save  (Uložit). 

 
Export dat pro zvolené jamky a/nebo vybrané 
sloupce výsledků do tabulkového editoru: 

 
1.   Zvolte File > Export > Results (Soubor > Export 

> Výsledky). 
 

2.  Zadejte název exportovaného souboru. 
 

3.  Klikněte Save  (Uložit). Otevře se dialogové 
okno Export Settings (Nastavení exportu). 



Kapitola 6  Analýza výsledků kvantifikace 

Poznámky    
  
  

 

Absolutní kvantifikace pomocí standardní křivky – Uživatelská příručka pro systémy 7300/7500/7500 Fast 71 

  

  

                                   

 

 Export výsledků absolutní kvantifikace 
 
 

4.  (Volitelné) Zvolte nastavení exportu: 

•   Export only selected wells - exportuje pouze  
vybrané jamky 

•   Apply Report Settings for Data Columns 
– exportuje sloupce zvolené v dialogovém 
okně Report Settings (Nastavení zprávy, 
viz “Zpráva” na straně 65). 

 
5.  Klikněte OK. 

 
Export grafů do programu PowerPoint: 

 
1.  Zvolte Tools > Graph Export > All to 

PowerPoint (Nástroje > Export grafu > Vše do 
PowerPointu) (nebo klikněte pravou myší 
v jakémkoliv grafu nebo destičce a zvolte Export 
All To PowerPoint – Exportovat vše do 
PowerPointu). 

 

Do PowerPointu budou exportovány náhledy ze 
všech záložek aktivního souboru (vyjma záložky 
Results > Report – Výsledky > Zpráva). 

 
Poznámka:  Chcete-li exportovat pouze aktuálně 
zobrazenou záložku, zvolte Tools > Graph Export 
> To PowerPoint (Nástroje > Export grafu > Do 
PowerPointu) (nebo klikněte pravou myší v 
jakémkoliv grafu nebo destičce a zvolte Export To 
PowerPoint – Exportovat do PowerPointu). 

 
 

2.  Potvrďte export do PowerPointu kliknutím OK. 
PowerPoint se otevře a zobrazí vaši prezentaci. 

 
Poznámka:  Do prezentace jsou automaticky 
přidány úvodní a informační snímek. 

 
 

3.  (Volitelné) Vaši prezentaci můžete v PowerPointu 
upravit. 

 
4.  Prezentaci v PowerPointu uložíte kliknutím na  

(Save - Uložit). 
 
Export vyobrazení destiček nebo grafů ve formátu JPEG: 

 
1.  Zvolte Tools > Graph Export > As JPEG (Nástroje > 

Export grafu > Jako JPEG) případně klikněte pravou 
myší v jakémkoliv grafu nebo destičce a zvolte 
Export as JPEG (Export ve formátu JPEG). 

6 
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Export výsledků absolutní kvantifikace 
 

 
 
 

Otevře se dialogové okno Export as JPEG (Export 
ve formátu JPEG). 

 
Poznámka: V tomto dialogovém okně můžete 
změnit přednastavené názvy souborů, zvolit 
rozlišení obrázku a zvolit, která vyobrazení 
destiček nebo grafy mají být exportovány a kde 
mají být exportované soubory uloženy. Více 
informací naleznete v  nápovědě. 

 
 

2.  Klikněte OK. 
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Příloha A 
 
 
 
 
 

Vytvoření detektorů A 
 
 
 
 
 
Před vytvořením dokumentu destičky a spuštěním běhu musíte 
definovat detektory pro všechny vzorky na destičce. Detektor 
je virtuálně vyjádřená genově nebo alelově specifická 
kombinace primerů a sondy, které jsou používány v dané eseji. 

 
Chcete-li vytvořit detektor: 

 
1.   Zvolte Tools > Detector Manager (Nástroje > 

Správce detektorů). 
 

Poznámka:  Nabídka Tools (Nástroje) je 
přístupná pouze je-li otevřen dokument destičky 
(jakýkoliv). 

 
 

2.   V okně Detector Manager zvolte File > New 
(Soubor > Nový) . 

 
 
 
 
 
 
 
 
 
 
 

2 
 

 3.  V dialogovém okně New Detector (Nový detektor) 
zadejte název (Name) detektoru. 3 

 

DŮLEŽITÉ!  Název detektoru musí být unikátní 4 
a měl by souviset s cílovým lokusem dané eseje 
(jako GAPDH nebo RNáza P). Nepoužívejte 5 
totéž jméno pro více detektorů. 

6 
 

4.  V poli Description (Popis) můžete zadat 
stručný popis detektoru. 

 

7 
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Příloha A  Vytvoření detektorů 
 
 
 
 

5.  V rozbalovacích nabídkách Reporter Dye (Reportérová barva) a Quencher Dye 
(Zhášeč) zvolte odpovídající barvy detektoru. 
 
Poznámka:  V těchto rozbalovacích nabídkách máte k dispozici pouze ty barvy, 
které byly předešle zadány pomocí Správce barev (Dye Manager). Pokud chcete 
použít barvu, která není na seznamu, použijte Správce barev (Dye Manager) pro její 
přidání a vraťte se zpět do tohoto kroku. Více informací naleznete v nápovědě. 

 
 
 

Poznámka:  Pro sondy TaqMan® zvolte zhášeč TAMRA a pro sondy TaqMan MGB 
zvolte možnost None (Žádný). 

 
 

6.  Klikněte do políčka Color (Barva) a v dialogovém okně Color (Barva) vyberte 
barvu pro daný detektor, potvrďte OK. 

 
7.  Do pole Notes (Poznámky) můžete zadat další údaje pro daný detektor. 

 
8.  Klikněte OK, čímž detektor uložíte a vrátíte se zpět do okna Správce detektorů 

(Detector Manager). 
 

9.  Opakujte kroky 2 až 8 i pro zbývající detektory. 
 

10. Po přidání dalších detektorů klikněte ve správci detektorů Done (Hotovo). 
 

Poznámka:  TaqMan® Gene Expression Assays (TaqMan® eseje pro kvantifikaci 
genové exprese) jsou dodávány s informačním souborem (assay information file - 
AIF). Tento textový soubor obsahuje informace o vámi objednaných esejích včetně 
identifikátoru eseje (ID number), umístění eseje v jamce, koncentrace primerů a jejich 
sekvence. Rovněž jsou zde informace o reportérových barvách a zhášečích, používaných 
v dané eseji. Při vytváření detektorů použijte informaci o těchto reportérových barvách a 
zhášečích a případně názvy genů nebo symboly názvů vzorků. Obsah informačního 
souboru (AIF) můžete zobrazit v tabulkovém editoru jako např. Microsoft® Excel®. 

 
 
 
 
 

Vzorový pokus 
 

Ve vzorovém pokusu byl vytvořen jediný detektor pro jedinou kvantifikovanou cílovou sekvenci. Detektor byl nazván 
RNase P (RNáza P) a označen modrou barvou. Použitá sonda byla typu TaqMan MGB a značená barvou FAM™. Sondy 
typu TaqMan MGB nesou nefluorescenční zhášeč. 

 

V pokusech, kde jsou kvantifikovány dvě nebo více cílových sekvencí, je nutné pro každou z nich vytvořit detektor. 
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Příloha B 
 
 
 

Doporučení pro vytváření 
standardních křivek 

 
 
 
 

Metodika absolutní kvantifikace pomocí systémů 7300/7500/7500 Fast požaduje, aby 
množství používaných standardů bylo stanoveno jiným nezávislým způsobem. Pro 
přípravu standardů se běžně používají plazmidová DNA nebo in vitro transkribovaná 
RNA. Jejich koncentrace se stanovuje pomocí A260 a přepočítává se na počet kopií 

pomocí molekulární hmotnosti DNA nebo RNA.  B 
 

Pro správné používání standardních křivek je nutné dodržet následující pokyny: 
 

•   Musí se jednat o čistý izolát DNA nebo RNA. Plazmidy připravené izolací 
z E. coli bývají často kontaminované RNA, což zvyšuje hodnotuA260 a zkresluje 
výpočet počtu kopií plazmidu. 

•   Jelikož ředící řada standardu musí mít koncentrace v rozsahu několika řádů, je 
zapotřebí přesně pipetovat. Plazmidová DNA nebo in vitro transkribovaná RNA 
musí být pro správné stanovení A260 dostatečně koncentrované. Tato 
koncentrovaná DNA nebo RNA musí být ředěna 106

 až 1012-krát, aby měla 
koncentraci srovnatelnou s koncentracemi v biologických vzorcích. 

•   Důležitým faktorem je stabilita ředěných standardů, zejména RNA. Rozdělte 
naředěné standardy do malých alikvotů, uložte je při −80 °C a nechte je roztát 
pouze jedenkrát těsně před použitím. Příklad postupu jak připravit spolehlivé 
standardy naleznete v Collins, et al. (1995), kde je popsán postup přípravy RNA 
standardů při kvantifikaci virové nálože. 

•   Obecně není možné používat DNA jako standard pro absolutní kvantifikaci RNA, 
protože neumožňuje kontrolovat efektivitu kroku reverzní transkripce. 
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Příloha B  Doporučení pro vytváření standardních křivek 
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Příloha C 
 
 
 
 
 

Analýza disociační křivky 
 
 
 
 
 
 

Přehled Za použití systémů 7300/7500/7500 Fast lze provádět analýzu disociace nukleových 
kyselin pomocí barviva SYBR® Green I. Účelem takové analýzy (analýza disociační 
křivky – křivky tání) je stanovit teplotu tání (melting temperature - Tm) cílové sekvence 
nukleové kyseliny v neznámém vzorku. V typickém případě se disociační křivky 
používají pro analýzu přítomnosti nespecifických produktů a při optimalizaci 
koncentrace primerů. 

 

Celá procedura je zahájena přípravou PCR destičky se vzorky a barvivem SYBR 
Green I. Destička je následně analyzována v přístroji, který byl naprogramován tak, aby 
pomalu (během několika minut) zvyšoval teplotu. 

 

Vazebné vlastnosti barviva SYBR Green I umožňují monitorovat proces hybridizace 
nukleových kyselin. V průběhu analýzy přístroj zaznamenává pokles fluorescence 
barviva SYBR Green vzniklý v důsledku disociace dvouřetězcové DNA. 

 
Výsledky Na následujícím obrázku je znázorněn typický průběh disociační křivky detekující 

vznik nespecifických produktů při amplifikaci vzorků cDNA. 
 

 
 

-6.0 Hlavní produkt 
Tm = 82 oC 

 
 

-5.0 
 
 

-4.0 
 
 
 

-3.0 
 
 
 

-2.0 

 
Dimery primerů 
Tm = 75 oC 

 
 
 

-1.0 
 
 

 0.0  
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Teplota (°C) 
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Kit Katalogové číslo 

SYBR®  Green RT-PCR Reagents 4310179 

SYBR®  Green PCR Core Reagents 4304886 

SYBR®  Green PCR Master Mix 4309155 

Power SYBR® Green PCR Master Mix 4367659 

 

Příloha C  Analýza disociační křivky 
 

 
 
 
 

Obrázek znázorňuje dva amplifikační píky, což je známka amplifikace dimerů primerů. 
Amplifikace specifického produktu je signalizována píkem o Tm 82 °C, zatímco produkt 
odpovídající dimeru primerů má typicky nižší Tm 75 °C. 

 

 
Zobrazení 
disociační 

křivky 

Chcete-li zobrazit disociační křivku, zvolte záložku Dissociation (Disociace) a v poli 
Data Type (Typ zobrazení) zvolte: 
 

•   Derivative (Derivace) – Zobrazí graf závislosti první derivace rychlosti 
změny fluorescence na teplotě. 

•   Raw (Hrubá data) – Zobrazí graf závislosti fluorescence na teplotě. 
 

 
 

V  nápovědě naleznete informace o tom, jak provádět analýzu disociační křivky pomocí 
systémů 7300/7500/7500 Fast. 

 

 
Pokusy zahrnující 

analýzu disociační 
křivky 

Podrobné vysvětlení chemizmu barviva SYBR Green I (váže se na dvouřetězcovou 
DNA) naleznete v příručkách: 
 

•   SYBR® Green PCR and RT-PCR Reagents Protocol (kat. č. 4304965) 

•   SYBR® Green PCR Master Mix Protocol (kat. č. 4310251) 
 

 
Kity pro analýzu 
disociační křivky 

Společnost Applied Biosystems nabízí následující kity: 
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D

Příloha D 
 
 
 
 
 

Izotermické pokusy 
 
 
 
 
 
 

Na přístrojích 7300/7500/7500 Fast lze provádět izotermické pokusy. 
 

 
Zadání 

izotermického 
pokusu 

1.  Zvolte Start > All Programs > Applied Biosystems 7300/7500/7500 Fast System 
> 7300/7500/7500 Fast System Software ( ) čímž spustíte SDS Software. 

 
2.  V dialogovém okně Quick Startup document zvolte Create New Document 

  (Vytvořit nový dokument). 
 
3.  V rozbalovacím menu Assay (Esej) v okně New Document Wizard (Průvodce 

 vytvořením nového dokumentu) zvolte Isothermal (Izotermický). 
 

                                       D 
 
4.  Definujte parametry destičky tak jak je popsáno v části “Vytvoření 

dokumentu destičky pro absolutní kvantifikaci” na straně 24 (systém 7300 
nebo Standard 7500) nebo na straně 38 (systém 7500 Fast). 

 
5.  Klikněte na záložku Instrument (Přístroj) čímž zobrazíte teplotní profil. 
 
6.  (Volitelné) Klikněte Add Cycle (Přidat cyklus), Add Hold (Přidat krok 

inkubace) nebo Add Step (Přidat krok) čímž přidáte další fáze izotermického 
pokusu. 
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Příloha D  Izotermické pokusy 
 
 
 
 

7.  (Volitelné) Chcete-li změnit přednastavenou teplotu 60 °C, klikněte do pole 
s vyobrazením teploty a zadejte novou hodnotu. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Klikněte do pole s vyobrazením teploty  
 a zadejte novou hodnotu 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.  (Volitelné) Klikněte Add Dissociation Stage (Přidat krok disociace). 
 

Poznámka:  Krok disociace používá standardní teplotní nastavení a nikoliv nastavení 
izotermického pokusu. 

 
 

9.  Dále postupujte tak jak je popsáno v částech “Nastavení teplotního profilu a 
spuštění běhu” na straně 29 (systém 7300 nebo Standard 7500) nebo na straně 43 
(systém 7500 Fast). 



Poznámky    
  
  

 

Absolutní kvantifikace pomocí standardní křivky – Uživatelská příručka pro systémy 7300/7500/7500 Fast 81 

  

  

Příloha E 
 
 
 
 
 

Absolutní kvantifikace – 
vzorový pokus 

 

 
 
 
 
 

Popis Účelem vzorového pokusu absolutní kvantifikace je stanovit počet kopií genu pro 
RNázu P ve dvou skupinách vzorků (replikátů). 

 
Pokus probíhá jako singleplex PCR (jediná reakce ve zkumavce) a primery a 
sondy jsou navrženy za použití programu Primer Express®. 

 
Sériovým ředěním vzorku o známém množství templátu se připraví ředící 
řada standardů. 

 
Vzorky i standardy jsou umístěny v jediné destičce a výsledky jsou po provedení 
běhu analyzovány za použití softwaru pro systémy 7300/7500/7500 Fast. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

E 



Příloha E  Absolutní kvantifikace - vzorový pokus 
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RT Mastermix – Destička typu Standard 
 

Složka 
 

µL/reakci µL/27 
    reakcí‡ 

10× pufr pro reverzní 
transkripci (Reverse 
Transcription Buffer) 

2.0 54 

25× dNTPs 0.8 21.6 

10× náhodné primery 2.0 54 

MultiScribe™ reverzní 
transkriptáza, 50 U/µL 

1.0 27 

Voda prostá nukleáz 4.2 113.4 

Celkem 10 270 

 

 
 
 
 
Vzorový pokus - postup 

 
1.  Proveďte návrh pokusu. (Viz Kapitola 2 na 

straně 10). 
 

a.  Označte neznámé vzorky, připravte 
standardní křivku a definujte počet 
replikátů. 

b.  Objednejte si reagencie pro provádění 
kvantifikace pomocí sond TaqMan® 

nebo navrhněte primery a sondy pomocí 
programu Primer Express®. 

 
2.  Izolujte celkovou RNA. (Viz Kapitola 3 na straně 16.) 

 
3.  Za použití kitu High-Capacity cDNA Reverse 

Transcription Kit přepište celkovou RNA do 
cDNA. (Viz Kapitola 3 na straně 17.) 

 
a.  Připravte si mastermix pro reverzní transkripci  

(RT) podle tabulky vpravo. Více informací 
naleznete v  protokolu High-Capacity cDNA 

Reverse Transcription Kits Protocol (Kat. č. 
4375575). 

 
 

CHEMICKÉ RIZIKO. 
Pufr 10 × Reverse Transcription Buffer 
může způsobit podráždění očí, kůže a 
dýchacího ústrojí. Přečtěte si bezpečnostní 
list a dodržujte pokyny při manipulaci. 
Používejte prostředky ochrany očí, ochranný 
oděv a rukavice. 

 
 
 
 

‡   Každá RT reakce má objem 20 µL (viz krok 3b). Potřebujete-li 5 µL 
cDNA pro každou PCR reakci (celkem 104 PCR reakcí, každá 
o objemu 50-µL) (viz krok 4), je zapotřebí provést 27 reakcí RT. Tato 
kalkulace již bere v úvahu nutnost použít vyšší objem, aby byly 
eliminovány ztráty vzniklé v důsledku pipetování a též za účelem 
uchování vzorku cDNA. 

 
b.  Připravte destičku pro přípravu cDNA: pipetujte 

do každé jamky destičky 

•   10 µL mastermixu RT 

•   10 µL vzorku RNA  

V jedné reakci o objemu 20 µL můžete přepsat 
až 2 µg celkové RNA do cDNA. 



Příloha E  Absolutní kvantifikace - vzorový pokus 

Poznámky    
  
  

 

Absolutní kvantifikace pomocí standardní křivky – Uživatelská příručka pro systémy 7300/7500/7500 Fast 83 

  

  

Krok Doba Teplota 

HOLD (Inkubace) 10 min 25 °C 

HOLD (Inkubace) 120 min 37 °C 

HOLD (Inkubace) 5 sec 85 °C 

 

 

PCR Master Mix‡ 
 

Reagencie Standard 
µL/ 

vzorek 

Fast µL/ 
vzorek 

Výsledná 
koncentrace 

TaqMan 
Universal PCR 
Master Mix (2×) 
nebo TaqMan 
Fast Universal 
PCR Master Mix 

25.0 10.0 1× 

Forward primer 5.0 2.0 50 až 900 
nM 

Reverzní primer 5.0 2.0 50 až 900 
nM 

Sonda TaqMan®  5.0 2.0 50 až 250 
nM 

Vzorek cDNA 5.0 2.0 10 až 100 
ng 

Voda prostá 
nukleáz 

5.0 2.0 — 

Celkem 50.0 20.0 — 

 

 

 
 
 
 

c.   Nastavte přístroj pro provedení kroku 
reverzní transkripce podle uvedeného 
teplotního profilu (dvoukroková RT-PCR).  

 
Poznámka:  Můžete použít i jednokrokovou 
RT-PCR jak je popsáno v části “Volba 
jedno- nebo dvoukrokové RT-PCR” na 
straně 12. Jednokroková RT-PCR se provádí 
pomocí mastermixu Standard Universal 
Master Mix for one-step RT-PCR nebo 
reagencií  EZ-RT. 

 
 

d.  Uchovejte cDNA při −20 °C až do dalšího použití. 
 

4.  Připravte si mastermix pro PCR podle tabulky 
vpravo. 

 

Podrobnější informace viz Kapitola 4 na straně 20. 
 

Poznámka:  Reakční objemy pro TaqMan® 

Gene Expression Assays (TaqMan® eseje pro 
kvantifikaci genové exprese) a  TaqMan® 

Custom Gene Expression Assays (TaqMan® 

eseje pro kvantifikaci genové exprese – na 
objednávku) jsou uvedeny v produktových 
letácích těchto výrobků. 

 
 
 

 
CHEMICKÉ RIZIKO. 

TaqMan Universal PCR Master Mix (2×) No 
AmpErase UNG může způsobit podráždění očí 
a kůže. Polknutí nebo inhalace může vést 
k nevolnosti.  Přečtěte si bezpečnostní list a 
dodržujte pokyny při manipulaci. Používejte 
prostředky ochrany očí, ochranný oděv a 
rukavice.  

 
 

 
 

 E 
‡   Pro vzorový pokus bylo připraveno osm mastermixů pro PCR, 
jeden pro každou ze dvou skupin vzorků (pro 37 reakcí) a jeden pro  
každý ze šesti standardů (pro 5 reakcí). Počítejte s objemem navíc 
pro ztráty způsobené pipetováním. Do každého mastermixu se 
přidává cDNA. 
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5.  Připravte destičku. 
 

a.  Označte si destičku a ujistěte se, že pro 
každou cílovou detekovanou sekvenci máte 
připravený soubor standardů. Standardy 
musí být na téže destičce jako je 
amplifikovaná cílová sekvence. 

b.  Pipetujte 50 µL příslušného PCR 
mastermixu (obsahujícího cDNA) do každé 
jamky destičky typu Standard nebo 20 µL 
v případě destičky typu Fast. 

 

c.  Destičku s reakcemi držte na ledu až do té 
doby, kdy jste připraveni ji umístit do 
přístroje 7300/7500/7500 Fast. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Standardní destička 
 
 
 
 
 
 

RN 
Population 1 

 
NTC STD 1250 STD 2500 

STD 5000 STD 10000 STD 20000 

 
RNase P 

Popu 
 
 
 

Destička Fast  

 
6.  Vytvořte dokument destičky pro absolutní 

kvantifikaci. (Viz  “Vytvoření dokumentu 
destičky pro absolutní kvantifikaci” na straně 24.) 

 

a.  Zvolte Start > All Programs > Applied 
Biosystems > 7300/7500/7500 Fast System 
> 7300/7500/7500 Fast System Software 
( ) čímž spustíte SDS software. 

 

b.  V okně Quick Startup document zvolte 
Create New Document (Vytvořit nový 
dokument). 
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E 

 

 
 
 
 

c.   V rozbalovacím menu Assay (Esej) v okně 
New Document Wizard (Průvodce 
vytvořením nového dokumentu) zvolte 
Standard Curve (Absolute Quantitation) 
(Standardní křivka – Absolutní 
kvantifikace), poté klikněte Next > (Další). 

 
DŮLEŽITÉ!  Pro absolutní kvantifikaci 
nemůžete použít dokument typu RQ 
(Relativní kvantifikace) a opačně. 

 
 
 
 
 
 

d.  Zvolte detektory, které chcete přidat do 
dokumentu destičky, poté klikněte Next > 
(Další). 

e.  Pro každou jamku definujte detektory a 
jejich úlohu, poté klikněte Finish 
(Ukončit). 

 
 
 
 
 
 
 
 
 
 
 
 

7.   Zadejte názvy vzorků v okně Well Inspector – 
klikněte  View > Well Inspector (Zobrazit > 
Prohlížeč jamek). 

 
DŮLEŽITÉ!  Pokud v pokusu nepoužíváte všechny  
jamky destičky, nevyřazujte je nyní z analýzy 
(pomocí funkce Omit - Vypustit). Můžete tak 
učinit až po skončení běhu. Více informací 
naleznete v  nápovědě. 

 
 

Obrázek vpravo znázorňuje vzorový dokument 
destičky pro absolutní kvantifikaci poté, co byly 
zadány názvy vzorků, detektor a úlohy detektoru 
pro každou jamku. 
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8.  Spusťte běh. 
 

a.  Zvolte záložku Instrument (Přístroj). 
 

Zobrazí se přednastavený teplotní profil 
(standardní podmínky pro PCR při 
dvoukrokové RT-PCR). Viz obrázek 
vpravo. 

Na obrázku na straně 86 je vyobrazen 
teplotní profil PCR pro systém 7500 Fast. 

 
 
 
 
 
 
 
 
 
 
 
 

b.  Zvolte File > Save (Soubor > Uložit), 
zadejte název dokumentu destičky a klikněte 
Save (Uložit). 

 

c.  Vložte destičku do přístroje. Ujistěte se, 
že destička má v přístroji správnou 
orientaci. 

d.  Klikněte Start. 
 

Po skončení běhu se objeví zpráva oznamující 
úspěšné či neúspěšné ukončení běhu. 

 
9.   Proveďte analýzu výsledků absolutní 

kvantifikace jak je popsáno v Kapitole 6. 
 

a.  Klikněte  (Analysis > Analysis Settings) 
(Analýza > Parametry analýzy), abyste 
nastavili parametry analýzy. Použijte 
možnost Auto Ct. (Viz “Nastavení 
parametrů analýzy” na straně 52.) 

 

b.   Klikněte OK & Reanalyze (OK & 
Analyzovat znovu) nebo zvolte Analysis 
> Analyze (Analýza > Analyzovat), čímž 
provedete analýzu dat. 

 
c.  V případě potřeby upravte ručně nastavení 

pozadí a prahu. (Viz “Nastavení pozadí  
prahu” na straně 54.) 
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d.   Klikněte OK & Reanalyze (OK & 
Analyzovat znovu) nebo zvolte Analysis > 
Analyze (Analýza > Analyzovat), čímž 
provedete analýzu dat. 

e.  Prostudujte výsledky analýzy.  
 

 
Závěr 

 

Ze standardní křivky odečtěte počet kopií genu pro 
RNázu P ve skupinách vzorků (populacích) 1 a 2. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
E 
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Anglicko-český  
terminologický slovník 

 
Annealing – Annealing, nasednutí primerů a sond 

na templát 
AQ – Absolutní kvantifikace 
Assay information file (AIF) – soubor informací o 

eseji 
Baseline- Pozadí (Baseline) 
Custom TaqMan Gene Expression Assays – 

TaqMan eseje pro kvantifikaci genové 
exprese, na objednávku 

End-Point PCR – End-Point PCR, PCR 
vyhodnocená až po skončení reakce 

Forward Primer – Forward primer 
Minor Groove Binder (MGB) – Minor 

Groove Binder, molekula vážící se do 
malého žlábku DNA (MGB) 

No Template Control – Netemplátová kontrola 
Passive Reference – Pasivní reference 
Real-Time PCR – Real-Time PCR, PCR v reálném 

čase 
Quencher – Zhášeč 
Replicate – Replikát 
Reporter Dye – Reportérová barva 
Reverse Primer – Reverzní primer 
RNase P – RNáza P 
TaqMan® Gene Expression Assays - TaqMan 

eseje pro kvantifikaci genové exprese  
Template – Templát 
Threshold – Práh (Threshold) 
Threshold Cycle – Prahový cyklus 
Unknown – Neznámý vzorek

 



  

  



  

  

Celosvětová prodejní a servisní síť 
 

Široká distribuční a servisní síť školených 

specialistů Applied Biosystems funguje ve 

150 zemích na šesti kontinentech. Adresy 

našich obchodních zastoupení a technické 

podpory získáte ve vaší místně příslušné 

pobočce nebo na internetové adrese 
www.appliedbiosystems.com. 

 
Posláním společnosti Applera je 

poskytování prvotřídních technologií a 

informací v oblasti life science. 

Společnost  Applera zahrnuje společnosti 

Applied Biosystems a Celera Genomics. 

 
Sídlo společnosti 

850 Lincoln Centre Drive  

Foster City, CA 94404 USA  

Telefon: +1 650.638.5800 

Bezplatná linka (v Severní Americe): +1 800.345.5224 

Fax: +1 650.638.5884 
 
 
07/2006 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
www.appliedbiosystems.com Dokument č. 4347825 Rev. E 

 




